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Exam Review notes

2. Introduction to the Internet
· An operating system is sys- tem software that controls basic computer operations. 
· The CPU (processor) is the computer component that is considered the “brain” of the computer, coordinating all input, output, and processing activities. CPU stands for central processing unit. 
· RAM (random access mem- ory) is computer memory that stores all open programs. Contents are only maintained as long as there is a constant supply of electricity. Don’t settle for less than 1 GB or RAM
· Much like a filing cabinet, a hard drive stores programs and data files. A constant sup- ply of electricity is not neces- sary to ensure the maintenance of hard drive contents. 
· ROM (read-only memory) is computer memory that cannot be changed. It stores critical programs, such as those neces- sary to boot the computer. 
· A desktop computer is a modular, stationary computer comprised of a system unit, keyboard, monitor, and mouse.  
· A laptop computer is a portable computer, usually smaller in physical size but more costly than a desktop.  Runs on a rechargeable battery.
· The motherboard is a circuit board housed in the system unit. It contains the CPU (cen- tral processing unit) and RAM. 
· Processor speed is usually measured in billions of hertz, or gigahertz (GHz). 
Computer Networking and Security 
· Software that identifies and isolates (or deletes) computer viruses is called antivirus software. 
· Software that removes spyware from a computer is called antispyware software. 
· [image: ]Software that acts as a barrier between your computer and the Internet, prohibiting unau- thorized Internet travel to or from the computer, is called a firewall. 
· A virus is a computer program that is purposely written to be destructive or annoying. 
· Spyware is software that has been downloaded and installed onto your computer to gather personal information, hijack your home page, or display unwanted advertising. 
· Cookies are text files provid- ing information identifying you as a return visitor to a Web site. 
· Phishing is an attempt by another person to acquire your personal information (and identity) through an e-mail scam. 
Understanding Home Networking
· A network is two or more computers linked together. 
· Broadband communication is a high-speed Internet connec- tion. Options include DSL, cable, and satellite. 
· Cable is a broadband Internet connection option that uses television cable to provide Internet access. 
· DSL (digital subscriber line) is high-speed Internet access provided through existing tele- phone lines. 
· A USB port is a connection on a computer that enables peripheral devices, such as printers, network adapters, scanners, and digital cameras, to connect. 
· A network interface card (NIC) is a component that is built into or connected to a computer, enabling the com- puter to communicate with a network. 
· A router is a device that enables two networks to com- municate. 
· A hub is a device that rebroad- casts communication to all equipment on a network. 
· An Ethernet network uses Ethernet protocol and wiring to connect computers. 
· The 802.11 standard is a method of communication used on wireless networks. 
[image: ]
· Bluetooth is a technology that facilitates low-bandwidth wire- less communication over short distances. 
Accessing the Internet
· A dial-up connection is a con- nection to the Internet over a standard telephone line. 
· A satellite connection uses a satellite dish to transmit data to and from the Internet. 
· Internal Computer Storage
· The binary system is the native format understood by computers, in which only two digits are used—zero and one. 
· A bit is either a one or a zero. It is a binary digit that represents the on or off state of a com- puter circuit. 
· A byte is comprised of eight bits. A byte represents a charac- ter on the keyboard. 
· ASCII (American Standard Code for Information Interchange) is a code for rep- resenting keyboard characters as numbers. 
· Unicode is a character-coding format that represents global characters from all languages. 
Input, Output, and Storage Devices 
· A keyboard is used to enter typed data into a computer. 
· A mouse is an input device that enables a user to point and click to make selections. 
· Hard copy is printed output. 
· Soft copy is output displayed on a computer monitor. 
· A CRT monitor is a large television-like computer output device. 
· An LCD monitor is a flat panel output device. 
· The resolution is the sharp- ness of a displayed image, determined by the number of pixels. 
· Pixels (picture elements) are small addressable areas on a monitor. 
· The refresh rate is the number of times per second a monitor redraws screen contents. 
· A hard disk is a large-capacity storage device housed in the system unit. 
· A CD drive reads from and writes to CDs (unless it is a CD-ROM disc, in which case it cannot be written to, only read from). 
· A DVD drive reads from and writes to DVDs (unless it is a DVD-ROM disc, in which case it cannot be written to, only read from). 
· A USB drive is a form of flash storage that can be carried with you. Simply plug the USB drive into any USB port to retrieve its contents. 
· A port is a physical interface through which external devices, such as printers and digital cameras, can be con- nected to a computer. 
[image: ]Windows Vista and Windows XP 
· The desktop is the screen that displays when you power on a computer. 
· Icons are small pictures on the desktop that represent programs, shortcuts, files, or folders. 
· The taskbar is the horizontal bar at the bottom of a window, providing information on open windows and providing access to system resources. 
· Plug and Play is a Windows feature that facilitates the installation of new hardware so that you simply plug it in and begin to use it. 
· A data file is an item that you create and to which you give a name, such as a document or worksheet. 
· A folder is a named area of storage on a disk. 
· A backup is a copy of a file. 
Productivity Software
· Productivity software includes programs that address general tasks, such as word processing, spreadsheet preparation, the creation of presentations, and database management. 
· An office suite is a collection of productivity software. 
· Online software is productiv- ity software that is accessed online. 
· Commercial software is soft- ware that is sold and is pro- tected by U.S. Copyright Law. 
· Shareware is software that is developed and distributed to online consumers for a limited time, usually as a trial version. 
· Freeware is copyrighted soft- ware that you can use as you like. 
Summary 
1. Understand computer components and computer types. Before purchasing a new computer, determine what you plan to use the computer for, and then match the system requirements to those tasks. You will select a computer based on its operating system. You will also con- sider the amount of RAM needed, as well as the processor and other components. 
2. Acquire a computer. You can purchase a computer from a retail outlet or local computer store, from an online auction, or as a customized model from an online site, or you can build a com- puter from parts. Depending on your level of computer expertise, you will identify the method of acquisition that suits your needs. 
3. Evaluate security software. There are several security risks to consider when using a computer. Viruses and spyware can attack your computer from the Internet, and without a firewall, you are vulnerable to hackers. Phishing is an e-mail scam that is widespread. To fend off security challenges, you must ensure that your computer is adequately protected with security soft- ware, such as antivirus software, antispyware software, a firewall, and a phishing filter (usu- ally associated with an Internet browser). 
4. Understand home networking. A home computer network enables computers to share printers and other peripherals, as well as information resources. Through either a wired or wireless network, several home computers can share the same Internet connection and the same printer. Special equipment that might be required includes a hub, router, and network inter- face adapters. Windows provides assistance with configuring a home network. Bluetooth is a data communication method utilizing short-range wireless data transmission between devices such as cell phones, PDAs, and computers. 
5. Access the Internet. Internet connection options include dial-up (which is very slow compared to other technology) and broadband methods. Broadband includes satellite, DSL, and cable. Each connection option contains unique advantages and disadvantages. 
6. Understand bits and bytes. Computer storage is measured in binary units. A bit is one binary digit. A collection of eight bits comprises a byte, which represents one character. It is important that you understand the concept of binary representation because a byte is the unit of measure- ment upon which software requirements are based. 
7. Identify character coding. The way in which bytes represent data is dictated by coding standards, such as ASCII and Unicode. ASCII is a coding method that represents all keyboard characters and some special characters with numbers. Unicode is more global, providing coding for characters in all languages. 
8. Identify input devices. The primary forms of input are the keyboard and mouse. Because computer systems are modular, you can purchase a mouse and keyboard that meet your computing needs, such as a remote or optical mouse, or a natural keyboard. 
9. Identify output devices. Output devices include monitors, for displaying soft copy, and printers, for printing hard copy. The most common type of monitor is an LCD, which is a flat-screen model. Both ink-jet and laser printers are popular home printer choices. 
10. Identify storage devices. Just as a filing cabinet retains contents permanently, computer storage devices such as a CD, DVD, or hard drive enable you to save files for later access. Unlike RAM, storage devices are not dependent on a supply of electricity to retain contents. A flash drive is a popular storage medium that enables you to transport files from one computer to another. 
11. Customize Windows Vista and Windows XP. Windows Vista and Windows XP share more com- monalities than differences. Both operating systems display a similar desktop, although the Windows Vista desktop is much more transparent, with a sweeping glass effect. Both systems provide access to the Control Panel, from which you can make system changes and check on system status. 
12. Manage folders and files. You will undoubtedly use a computer to create files, such as documents or spreadsheets. Computer folders are named areas of storage in which you can save files. Just as you might organize a filing cabinet with individual folders, you can create folders on a storage medium to better organize computer files. 
13. 13. Identify types of productivity software. Productivity software is software that helps you accom- plish general tasks, such as word processing and spreadsheet creation. Microsoft Office 2007 is an example of productivity software, as are Microsoft Works and the Corel, Lotus, and StarOffice suites. Many people prefer the availability of online software, which provides pro- ductivity software and file storage regardless of where you find yourself. 
14. 14. Acquire software. When you purchase or obtain software, you only have the right to use the soft- ware; it is not yours. As such, you usually have to agree to a license. Types of software licenses include freeware, shareware, and commercial. Shareware is usually available as a “try before you buy” product, whereas freeware is free to copy without purchase. Commercial software is software that you buy. It is copyrighted, which means that you are not allowed to duplicate it. 
Mainframe: A large computer that supports hundreds or thousands of computers simultaneously.
Minicomputer: A smaller, less powerful computer than a mainframe designed to serve a small number of applications to multiple users.

3. Introduction to the Internet

The Internet: A group of interconnected networks that spans the world
· A global information network compromised of millions of interconnected computers to disseminate information and communicate with other people around the world
· Internet is a popular avenue for e-commerce- conduction online business through advertising, selling and buying products

E-commerce:  Is the avenue for conducting business over the Internet

Understanding the World Wide Web 
World Wide Web: is a subset of the Internet that supports graphical point-and-click navigation to inform and resources

Webpage: Is a single document formatted to be used on the web
-Typically consists of text, graphics, animation, and/or sound and that is designed to be used on the Web 

Website: is a collection of webpages for an organization or entity

Hyperlink: Is a text or graphic element that, when clicked, displays another area of the same web page of displays another Web page or resource 
-Web pages consist of Hyperlinks

Protocol: A set of rules that govern data formats and transmission
-The primary protocol for the Web is Hypertext Transfer transmission 

HyperText Transfer Protocol (HTTP): Is a set of rules that specifies data format and transmission of web pages 
-Dedicates how Web pages are formatted and how data must be transmitted across the web

Web Server: Is a computer that stores webpages and transmits data when requested 
-When a Web server receives a report that someone has entered the Web address or clicked a link, it fetches the data and transmits the request Web page to the computer that initiated the request. The receiving computer then displays the Web page onscreen for the user 

Hypertext markup language (HTML): Is an Authoring language used to create Web Pages 

Accessing and Navigating a Web Site

Internet Explorer (IE) 7: Is the newest versions of Microsoft’s browser 

Browser: Is a software application used to located and display Web resources

Internet Service Provider (ISP):  Is a company that provides access to the Internet
-To access the Internet, you must contract with an Internet service provider 
-Major providers inculde
· Bell (Sympatico)
· Videotron (in Quebec only)
· Rogers (rare in Quebec)
· Many other smaller companies
· If you want to connect to the Internet at home, you will have to contact one of these companies either in person or by phone. They will set up your connection (using cables, a modem, and/or a router) to the Internet using their network.
· The various ISP companies all have package plans that offer different Internet connection speeds (Dial-up, DSL, cable, and so on) and features. The speeds and features available often depend on where you live, and the choice you make will depend on how you intend to use the Internet. A lot of files uploading and downloading (especially music and video) will require higher speed (transfer rate).
Identify Components of a URL

Uniform Resource Locator:  The specific address of a World Wide Web file 
-A URL is actually composed of three parts- the protocol, the name of the company or entity that maintains the Website, and an identifying suffix.

File transfer Protocol (ftp): Is used for uploading, storing, and downloading sharable files over the Internet 

Domain: Is a name for an entity’s Web site or server

Top-level domain: is a suffix that identifies that type of organization sponsoring a Web site

Home page:  The page that displays when you open internet explorer
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Address bar: (where the website URL goes)

Temporary Internet File: A copy of a web page that is saved onto your hard drive for ease of access later
-Refresh a webpage or use F5
-Scroll bar, scroll arrow, scroll box
-Open a new browser window click ctrl N on the keyboard

Quick tabs feature: 
-To view a thumbnail of all open tabs

Printing a webpage

The print preview toolbar does the following:
· Print the Webpage
· Select portrait or landscape orientation 
· Open the Page Set up dialog box
· Display or hide headers and footers
· View at Full Width or Full Page
· Show Multiple Pages
· Change the print size 

Frame: Is a boxed area, usually located at the side or top of a Web page, containing links and additional information

Browser Options and Internet searches
Phishing: The act of sending fraudulent e-mail in an attempt to collect personal information by pretending to be a legitimate enterprise 
-E-mail scam where they try to gather personal information or account numbers

Cookie: a text file saved on your computer by a Website that you visited 

Favorite or Bookmark: is a marker tat identified a webpage so that you can quickly display the page later
-Favorites Center is where you can keep track of favorites sites adding, deleting and renaming the references whenever you like
-Click Ctrl+D to display the Add to favorites dialog box 
-Press Alt+ C to open the favorites center

 Pop-up: Is an uninvited browser window that appears in front of an active browser window

Pop-under: is an uninvited browser window that appears when an active browser window is closed
-Usually advertising in attempt to sell a product

Search engine: Is a website that provides search tools so that you can find information on a topic

Keyword is a word or phrase that describe information that you want to retrieve

E-mail: The transmission of messages over a communication network 

Windows Mail: is an e-mail program included with Windows Vista

Windows Contacts:  is a windows Vista feature that stores information about people with whom you communicate electronically

Attachment: Is a file that is sent along with an e-mail message
 
Instant Message: Is a form of online communication that enables you to type messages from others whoa re online at the same time

Blog: A personal journal entry that is posted online

Networks
-Networks are two or more connected computers, plus the various peripheral devices that are attached to them
- Each object connected to a network, whether it is a computer or a peripheral device, is known as a node.
- Networks allow the computers to communicate and ultimately share information and resources.
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Network Components:
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Network Adapters
- Each node (device or computer) in a network must have a network adapter.
- Network adapter: is a device that allows the node to communicate with other nodes

Modems
-Modems are devices that allow your computer, which is digital, to understand analog signals coming through your phone line.

Routers and switches 
-Routers handle the transfer of data from network to network. For instance, they are essential when connecting your home network to the Internet.
- Switches work within a network. These devices make sure that data is transferred to the correct network node

Internet Connections
-Dial-Up Modem Up to 56 Kbps (kilobytes per second) transfer rate 
-DSL (digital Subscriber Line) Modem  Up to 1.5Mbps (Megabytes per second) 
-Cable Modem  Variable transfer rate 
-Fiber Optic Internet Up to 30 Mbps 

- Wireless networks are becoming more and more popular, especially due to the popularities of laptops and other portable devices  
- They do not require your computer to be physically plugged into the Internet modem
-They use routers and a wireless network adapter (today, this is built in to all laptops)
- Wireless networks work in the same way as regular wired networks except that once you connect to the 
[image: ]Internet, your adapter connects to the router which in turn connects to an ISP. 802.11 standard is a method of communication used on wireless networks.

Hotspot
-Hotspot: is a place that has wireless access to the Internet (airports, hotels, etc.)
-Most hotspots are not secure (Anyone can access them)
- Some hotspots have authentication enabled, meaning that you have to enter a username and password to access them.  Most hotels, schools and libraries have this authentication and provide you with a username and password when asked

Topology: 
What is a Browser?
[image: ]A browser is an application that allows you to locate, view and navigate Web pages. There are several Web browsers available, but the most commonly used are Internet Explorer, Mozilla Firefox, Safari and Opera. Most Web browsers have extra features that allow you to set up your favorite websites, your home page and your privacy settings. Computers that you buy in a store usually come with Windows Vista (operating system) and Internet Explorer 7. Internet Explorer 7 now has Tabs. It allows you to view many websites in the same window. Different browsers can be downloaded from their developer sites, but most computers come with at least one browser already installed. Web browsers enable you to navigate the Web by clicking on hyperlinks.
Evolution of Browsers
Browsers have had quite an extensive history of competition and still do. Netscape was the first major player in the browser game. It made its start in the early 1990s. Opera followed soon afterwards.



The most popular browsers currently in use are Internet Explorer and Mozilla Firefox. The table below lists some common browsers and some similarities and differences which may influence your preference.
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Summary 
1. Understand the World Wide Web. The World Wide Web is a set of interconnected networks that is accessible to anyone with an Internet connection. Certain rules, or protocol, govern the way that Web pages are displayed and accessed. A Web site is a collection of one or more Web pages. To access a Web site, you can type the address in the Address bar of a browser, such as Internet Explorer 7. 
2. Access and navigate a Web site. To access a Web site, you must either type a URL in the browser Address bar or click a hyperlink on a Web page. A URL is composed of several parts, includ- ing the protocol, company or entity name, and a top-level domain. A hyperlink can be either graphic or text. 
3. Print Web pages. Although Web pages are not necessarily designed to be printed, you can print a Web page using Print settings provided by Internet Explorer. You can preview a page first and change print settings to modify the page orientation and add headers and footers. 
4. Download information and graphics. The Web is rich with resources, some of which you can down- load to your computer. Files or programs are often available as downloads from Web sites. In addition, you can collect graphics, such as photographs and clip art from the Web. 
5. Work with Favorites and the History lists. Two ways of finding sites you have previously visited are the History and Favorites lists. The History list includes sites visited during the past several weeks, although you can control the number of days or weeks the history is kept. The Favorites list is an area to which you can add links to your favorite, or often visited, Web sites. 
6. Manage Internet options. You can easily customize certain browser settings, specifically those that deal with your privacy and security. Cookies, which are small identifying text files copied to your computer when you visit Web pages, are most often not harmful. However, you can delete them if you like. Internet Explorer includes a Phishing Filter and Pop-up Blocker that help protect your privacy and keep annoying pop-up ads to a minimum. You can also change your browser’s home page. 
7. Use search engines. The Web is a valuable source of information. Using a search resource, such as Google or Windows Live Search, you can provide keywords that return information on just about any topic imaginable. You will learn to select keywords that narrow the search so that you are presented with relevant information. 
8. Communicate through Windows Mail. Windows Mail is a program provided with Windows Vista. Using Windows Mail, you can view and manage e-mail from your ISP account. Windows Mail works in conjunction with Windows Contacts, a program that stores information on those people or organizations with which you regularly communicate. 
9. Communicate through instant messages and blogs. Online communication also includes instant messages and blogs. An instant message is a personal typewritten conversation between two or more people who are online at the same time. A blog is a personal online journal in which you can record and post anything. Be aware that neither blogs nor instant messages are necessarily private. Several Web sites provide free blogging space, and you can easily download free software that facilitates instant messaging. 

4.Software

Windows XP: The primary operating system for personal computers

Windows Vista:  The newest version of the Windows operating system 

Windows XP home edition: Focuses on entertainment and home use
-Includes a media player, support for digital photography and an instant messenger

Windows XP Professional edition: Designed to support business systems

Windows XP media center Edition: coordinates multimedia elements
-Enables you to enjoy video, audio, pictures and television on your computer monitor

Fats user switching: is a windows feature that allows you to quickly move from one user account to another 

Desktop: Contains icons and a taskbar. It is displayed when a computer first boots up

Icon: is a pictorial element representing a program, file, website or short cut

Taskbar:  is the horizontal bar that allows you to move among open windows and provides access to system resources (blue bar at bottom of screen)

Start button:  Provides access to programs and other system resources

Start Menu: is displayed when you click the start button
· Start menu is divided into two columns
· The left column displays the pinned items list, typically and Internet browser program and an e-mail program that are :”pinned” to the top of the column, and a list of the most recently used programs
· The right column of the start menu provides access to windows folders such as my music, my documents, and my pictures. The right column also contains entries for the Control panel, help and support and search 

Quick Launch toolbar: Contains programs icons, making it possible to open programs with a single click

Notification Area: Found at the right side of the taskbar, displays icons for background programs and system processes (where a USB is)

Windows Desktop Search: Helps you find anything on your computer

Window: An enclosed rectangular area representing a program or data

Multitasking: Is the ability to run more than one program at a time

Task Pane: A bar that Provides support for a currently selected item or window
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Title Bar:  The shaded bar at the top of every window

Minimize button: removes a window from view but not from memory

Maximize button: Causes a window to fill the screen 

Restore down button: returns a window to the size it was before it was maximized 

Close button:  removes a window form memory

Drop-down menu: displays more selections pertaining the menu item

Menu bar: a horizontal bar at the top of a window containing options to enable you to work with an application 

Toolbar: Usually found at the top or side of a window, contains buttons that are accessed more quickly than menu selections

Status bar: Displays summary information about the selected window or object 

Scrollbar: enabled you to control which part of a window is in view at anytime

Thumbnail: Is a miniature display of a folder or page

Dialog Box:  Is a special window that requests input or presents information
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Option button or radio button: is a mutually exclusive selection in a dialog box

Text box: Enables you to give an instruction by typing in a box

Spin Button: is a dialog box feature with an up or down arrow to increase or decrease a value

Check Boxes: Enables you to select one or more items that are not mutually exclusive 

List Box: Presents several items, any of which can be selected 

Command Button: Is a dialog box item that you click to accept or cancel selections

Help and Support Center: Provides assistance on Windows topics

Files and Folders
File: A collection of data or information that has a name
· Program file: Is part of a software program, such as Microsoft word
· Data File: Is an item that you create and to which you give a name, such as a document
· Filename: Is an identifier that you give a file when you save it 

Folder: Is an object or container that can hold multiple files and subfolders 

Creating a New folder
-Picture  Storage devices, 1. Storage devices selected, 2. File ,menu with new selected, 3. New folder option

Deleting a folder
-It’s good go delete folders you no longer need
-If you delete a folder, you are also deleting the contents or files within that folder
-Deleted folders can be recovered from the recycle bin

File name Extensions
ExtensionType of document Application that uses the extension 
-.docWord-processing document  Microsoft Word 2003
-.docx Word-processing document Microsoft Word 2007
-.wks word-processing document  Microsoft Works word processing
-.wpd Word-processing document  Corel WordPerfect
-.xls Spreadsheet Microsoft Excel
-.slr spreadsheet  Microsoft Works spreadsheet
-.mbd database  Microsoft Access
-.ppt Powerpoint presentation Microsoft PowerPoint
- pdf.  Portable Document Format Adobe Acrobat or Adobe Reader
-rtf.  Text  Any program that can read text documents
-.txt Text Any program that can read text documents
-htm. Or htlm.  Web page  Any program that can read Hypertext Markup Language 
-.bmp bitmap image Microsoft Paint
- .zip compressed file  Winzip
 
Moving and copying
-The easiest way to move or copy a file is to drag it from one folder to another as needed in the Windows Explorer.
-When you drag a file or folder to the same storage device, for example the flash drive, the file or folder will be moved
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Windows Explorer: Displays a tree structure of the devices and folders on your computer

Shortcut Menu: Displays a list of commands when you right-click an item or screen element 

Backup: Is a copy of a file 

Recycle Bin: Holds files and folders deleted from the hard drive

Background: is the area of a display screen behind the desktop icons

Screen saver: Is a moving graphic or image that takes over the display screen when the user is idle
Control Panel:  Enables you to change system settings

Wizard: Is a set guided instruction 

User account: Specifies a user’s settings, permissions and customizations 

Shortcut: Is a special type of file that points to another file or device

Search Companion: Is a search tool option in Windows XP

What is software?
· Software: is “a set of instructions that tell a computer what to do”.
· These instructions are also known as programs
Software is essential if a computer is to be useful to anyone other than a skilled programmer
· Different then computer hardware because It does not need any connection to the computer
· There is no need for cables, jacks or connectors
· Software is just data - files (instructions) that are in computer memory and are executed upon command.
· Examples: Microsoft office (word, power point) Internet Explorer, Windows Live Messenger, Notepad, Paint, Adobe Photoshop, Solitaire, even Windows Vista and Windows XP anything that allows you to do anything on the computer

Types of software 

1. System Software
· Actually interfaces with the hardware
· Allows the computer’s hardware to work with application software and in turn work for you.
· This category is mostly made up of Operating system software
· They help you use the computer and avoid typing computer code and they have user-friendly interfaces (mouse, keyboard, icons, etc.).
· Does the work for you 
· It make the computer’s inner workings easier to handle, it also gives you faster performance by categorizing everything in human terms. It also manages all your files for you

2. Programming Software
· Used mainly by programmers and computer scientists
· Used for programmers to create other software
· Includes compilers, editors, interpreters, debuggers, and more (wont be focused on)
· Programmers use different languages such as Java, C++, or PHP to use these tools.
· Example: Visual Studio, Eclipse, MySQL

3. Application Software
· The software that’s used the most
· Includes utility programs, word-processing programs, spreadsheet software, digital image-editing, games, workplace-specific software, databases, medical software, business software, and more
· Examples: Word, PowerPoint, Solitaire, call of duty, Adobe Photoshop, ITunes, Real player

How Does Software Work?
· Let’s keep things simple. After all, this isn’t a computer science or software engineering course.
· When the operating system boots up, it organizes the storage and all of the files for you. When you use a computer for any task, your instructions (keyboard typing, mouse click) are interpreted by the operating system. What we think of as simple tasks are considerably complicated for computers to translate, but in the end, the computer performs them much faster than we could. The simple act of entering text and printing a sheet requires long lines of programming code.
· For example, imagine that you simply want to start Microsoft Word. That’s a system task in itself (even moving the mouse is a task).
· Click on the Microsoft Word icon or shortcut.
· The CPU processes the instruction and activates the Microsoft Word executable file (in memory). This starts the Word program.
· The Operating System interprets this as “input” and sends the instruction to the computer’s CPU (brain). It also saves this action.
· Now you are able to use the program, which interprets your keystrokes and displays the letters you type.
· The previous example was a very simplified example of a basic action. Just imagine what goes on in your computer when you ask it to save, copy, paste, play videos, and so on.
· In essence, what computer software does is interpret your actions when using input devices in order to hopefully do something useful.
· The operating system, therefore, is the interface in between you and the CPU. It receives your input and saves it in storage while the CPU carries your instructions out. The CPU reads all these actions as machine code (a very low-level computer language). Today, CPUs are extremely fast. The second you click on a software icon, the software activates.
· Application software does the same thing, but the tasks it lets you perform can be much more specific, such as display the letter ‘T’, or play this exact music file, or load this web page.

What is an operating system?
· An Operating System (OS) is a complex program that manages all of the system files used by your computer. It manages the flow of data in your computer.
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OS Functions:
· Allow the user to interact with the computer
· Manage the CPU
· Manage memory and storage
· Manage system hardware and peripherals
· Manage applications software and memory allocation (coordination)
What Happens When You Turn on the Computer?
· When you turn on your computer, a process called bootstrapping starts up and loads the operating system into memory (such as Windows XP, Windows Vista, Mac OS, etc.) Most operating systems are stored on the hard disk.
· Often when you turn on the computer you see a black screen with gray or white writing running down the page very quickly. Nowadays this only lasts for a couple of seconds before you see the Windows splash-page. Once upon a time, computers had no operating systems and users worked in that black screen.
· After your operating system loads you are in control of the computer. You can sign in or begin opening applications.
What does the Operating System do?
· As mentioned in the previous section, the operating system is the interface that helps you communicate with the computer. It displays all the software and hardware that you have access to in terms that you can understand. It translates the computer’s languages (machine code and programming languages) into a language you can understand.
· The OS does this by displaying a Graphical User Interface (GUI). This system is the one that lets you use the mouse and keyboard for your desired actions. It also includes the icons displayed on the desktop.
· Evolution of OS interfaces:
· Command Line Interface
· Type commands to communicate
· Very complicated for most users
· Menu-driven Interface
· Select tasks from a list displayed on the screen
· Still not easy enough for most people
· Graphical User Interface
· Graphics and point-and-click technology
· The Operating System also allows you to manage your files by creating hierarchies of folders and files within drives. This lets you store your data in an organized and efficient way.
· The OS also multi-tasks different programs so that it seems like the computer is doing more than one or two things at a time. It allows you to have many programs running at once (depending on how much memory the computer has). What is really happening is that the OS manages how the CPU handles all of these tasks so that it is constantly busy completing different tasks for different programs.
Summary 
1. Identify components on the Windows desktop. The desktop is displayed when the computer is first powered on. Just like a normal desktop that you might use at home, the computer desktop is an area to hold projects, software, and files (in bordered areas called windows). Icons on the desktop represent software, files, Web sites, and shortcuts. You can maintain your computer desktop, keeping clutter to a minimum and customizing the background and other settings. 
2. Work with windows, menus, and dialog boxes. A window can be minimized, maximized, resized, moved, and closed. When working with windows, you often will use menus that enable you to make selections relevant to the current task. Often a menu selection will cause a dialog box to display, presenting information and asking for your direction or input. 
3. Use the Help Support Center. Although no printed reference manuals are packaged with Windows XP, there is a wealth of information in the Help and Support Center. Available as a Start menu selection, Help and Support is an indexed tool whereby you can search for information on just about any Windows-related topic. 
4. Work with folders. A folder is a storage area on a disk in which you can place files and subfolders. You can use My Computer or Windows Explorer to create folders. You can organize folders in any way that you like. 
5. Manage folders and files in Windows Explorer. Windows XP provides tools that assist you in manag- ing files and folders. Windows Explorer is a program that enables you to view the contents of disks as well as to create folders and move or copy items into them. When you copy an item, a duplicate is saved in another folder or on another drive. When you move an item, the file or folder is removed from its original location and placed in another. The easiest way to move or copy items is to right-click and drag them from one area to another in Windows Explorer. 
6. Delete items and manage the Recycle Bin. The Recycle Bin is a holding area for items that have been deleted from the hard drive. It does not, however, retain items removed from other media, such as CDs or USB drives. If you decide that you want to retrieve a deleted item, you can open the Recycle Bin, click the item, and click Restore this item. 
7. Change the display settings. As you work with a computer, you probably will want to change the display to a more colorful or personal background. You also might select a screen saver and adjust the screen resolution. All of those activities are possible by working with the Display Properties dialog box. 
8. Change computer settings using the Control Panel. The Control Panel is a Windows feature that enables you to change certain computer settings, such as the desktop background, screen saver, mouse buttons and pointers, and clock. Through the Control Panel, you also can view system settings, create user accounts, uninstall software, and manage printers and other peripheral devices. 
9. Create shortcuts on the desktop and Quick Launch toolbar. A shortcut is a file that points to another file or device. You might want to create a shortcut on the desktop so that you can simply double-click it when you want to open the program to which the shortcut points. Shortcuts are most often placed on the desktop by right-clicking and dragging the file to the desktop. Similarly, you can create shortcuts on the Quick Launch toolbar by clicking and dragging items to the toolbar. 
10. Use Windows Desktop Search. In a perfect world, you would never lose files or misplace them. Realistically, though, you are very likely to create a file and misplace it, or download an item from the Internet and not pay attention to where it is saved on your system. Windows Desktop Search makes it easy to find a lost item if you know anything about it, such as part of the filename or file content. Windows Desktop Search indexes files, folders, and e-mail so that items can be found quickly. 
5. Office Fundamentals 

Word processing software: Is used primarily with text to create, edit, and format documents

Spreadsheet software: Is used primarily with numbers to create worksheets 

Presentation Graphics software:  is used primarily to create electronic slide shows

Relational Database Software: Is used to store data and convert it into information
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User interface: Is the meeting point between computer software and the person using it 
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Office button: is an icon that, when clicked displays the office menu

Office menu: contains commands that work with an entire file or with the program 
· A list of commands that you can perform on the entire file or for the specific office program
· Example: When you want to preform a task that involves the entire document, such as saving, printing, or sharing a file with others, you use the commands on the office menu 
· to display the office menu you can click ALT+F
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Quick Access toolbar: Contains buttons frequently used commands
 Such as saving or undoing files
This toolbar keeps buttons for common tasks on the screen at all times, enabling you to be more productive in using these frequently used commands

Title Bar: Displays the program and filename at the top of a window
 Document 1

Ribbon: Is a large strip of visual commands that enables you to preform tasks
 Most important section of the interface: It is the command center of Microsoft Office 2007 interface, providing access to the functionality of the programs [image: MAc HD:Users:Georgia:Desktop:Screen Shot 2015-06-04 at 12.24.33 PM.png]
Tabs: Which look like folder tabs, divide the Ribbon into task-oriented categories 
 Tab examples: Home tab, page layout, Reference, Mailings, Review and View

Groups: Organize similar commands together within each tab
 Example: the home tab in word contains these Groups (clipboard, font, paragraph, styles and editing)

Command:  Is a visual icon in each group that you click to perform a task
 They appear as visual icons or buttons within the groups of the ribbon
Example: the Bold command on fonts

Dialog box: is a window that provides options related to a group of commands

Dialog box Launcher: A small icon that, when clicked, opens a related dialog box

Gallery: A set of options that appears as a thumbnail in graphic
 Example: If you create a chart in Excel, a gallery of charts formatting options provides numerous choices for formatting the chart 

Live preview: Provides a preview of the results for gallery options 
 Example: When you move your mouse pointer over the gallery thumbnails, you see how each formatting option affect the selected item in your document, worksheet or presentation.

Contextual Tab: is a tab that provides specialization commands that display only when the object they affect is selected
Example: if you insert a picture on a slide, PowerPoint displays a contextual tab on the ribbon with commands specifically relates to the selected image. When you click outside the picture to deselect it, the contextual tab disappears 
Key Tip: is the letter or number that displays over each feature on the Ribbon and Quick Access Toolbar and is the key- board equivalent that you press. 
Status Bar: Displays below the document and provides information about the open file and buttons for quick access
Example: the word status bar shows the current page, total number to pages, total words in the document, and proofreading status 

Views
Print layout: Displays the document as it will appear when printed

Full screen Reading:  Displays the document on the entire screen to make reading long documents easier. To remove Full Screen Reading, press the Esc on the Keyboard

Web Page: Displays the document as it would look as a Web page

Outline: Displays the document as an outline

Draft:  Displays the document for quick editing without additional elements such as headers or footers

Zoom Slider: Enables you to increase or decrease the magnification of the file onscreen
 You can change the display to zoom in on the file to get a close up view, or you can zoom out to get an overview of the file 

Enhanced ScreenTip: Displays the name and brief description of a command when you rest the pointer on a command 

Universal Tasks
· One of the most useful and important aspects of using computers is the ability to save and reuse information
· Three fundamental tasks are so important for productivity that they are considered universal to most every computer program, including office 2007:
· Opening files that have been saved
· Saving files you create 
· Printing files

Intersection point: is the blinking vertical line in the document, cell, slideshow, or database table designating the current location where text you type displays

Look in: Provides a hierarchical view of structure of folders and subfolders on your computer or on any computer network you are attached to. Move up or down in the structure to find a specific location or folder and then click the desired location to select it 

My places bar: Provides a list of shortcut links to specific folders on your computer and locations on a computer network that you are attached to. Click a link to select it, and the file list changes to display subfolders and files in that location.

Toolbar and Buttons
Previous folder: Returns to the previous folder you viewed

Up one level: Moves up one level in the folder structure from the current folder

Delete: Deletes the selected file or selected folder

Create New Folder: Creates a new folder within the current folder

Views: Changes the way the list of folder and files displays in the file list

Open options
Open: open the selected file with the ability to read and write (edit)

Open read-only: Opens the selected file with the ability to read the contents but prevents you from changing or editing it

Open as copy:  Opens the selected file as a copy of the original so that if you, edit the file, the original remains unchanged 

Open in Browser: opens the selected file in a Web browser

Open with Transform: Opens a file and provides the ability to transform it into another type of document, such as an HTML document
Open and Repair: Opens the selected file and attempts to repair any damage if you have difficultly opening a file, try to open it by selecting Open and Repair

Saving files
· When you work on files they are stored in the temporary memory or RAM on your computer

Save command: 
Saves the open document: 
· If this sis the first time the document is being saved. Office 2007 opens the Save as dialog box so that you can name the file
· If this document was save previously, the document is automatically saved using the original filename
Save As command:
Opens the Save As dialog box:
· If this I the first time the document is being saved, use the Save As dialog box to name the file
· If this document was saved previously, use this option to save the file with a new name, in a new location, or as a new file type preserving the original file with its original name

Macro: Is a small program that automates tasks in a file

Virus Checker: Is software that scans files for hidden program that can damage your computer 

Template: Is a file that contains formatting and design elements

Shortcut menu: Displays when you right-click the mouse on an object and provides a list of commands pertaining to the object you clicked

Portrait orientation: Is longer than it is wide- like the portrait of a person

Landscape Orientation: Is wider than it is long, resembling scene 

Print option

All:  Select to print all the pages in the file

Current page/slide:  Select to print only the page or slide with the insertion point. This is a handy feature when you notice an error in a file, and you only want to reprint the correct page 

Pages: Select to print only specific pages in a document. You must specify page numbers in the text box 

Numbers of copies: Change the number of copies printed from the default 1 to the number desired

Collate: Click if you are printing multiple copies of a mulit-page file, and you want to print an entire first copy before printing on entire second copy, and so forth 

Print what: Select from options on what to print, varying with each application 

Selection: Select to print only selected text of objects in an Excel worksheet

Active sheet(s): Select to print only the active worksheet(s) in Excel
Entire workbook: Select to print all worksheets in the Excel workbook

Duplex Printer: Prints on both sides of the page

Manual duplex: operation allows you to print on both sides of the paper by printing first on one side and then on the other

Two ways to print:
· Select Quick Print from the office menu
· Customize the Quick Access toolbar to add the Print icon. Click the icon to print the current file without opening the Print Dialog box

Most basic Tasks in word fall into two categories:
1. Editing a document
2. Formatting a document

Mini Toolbar: Displays above the selected text as semitransparent and repeats often used commands
 The tool bar that pops up after you highlight a text to change the colour and shit

Easy Text selection in word

Select a word: Double-click the word

One line of text: Point the mouse to the left of the line and when the mouse pointer changes to a right-pointing arrow, click the mouse 

A sentence: Hold down Ctrl and click in the sentence to select 

A paragraph: Triple-click the mouse in the paragraph 

One character to the left of the intersection point: Hold down Shift in the paragraph 

One character to the right of the intersection point: hold down shift and press the right arrow key 

Insert: Is adding text in a document

Overtyping Mode: replaces the existing text with text you type character by character

Cut: Removes the original text or object from its current location

Copy:  Makes a duplicate copy of the text or object, leaving the original intact

Paste:  Places the cut or copied text or object in the new location

Clipboard:  Is a memory location that holds up to 24 items for you to paste into the current document, another file, or another application

Find: Locates a word or group of words in a document 

Replace: not only find text, it replaces a word or group of words with other text
Go To:  Moves the insertion point to a specific location in the document

Undo: A Command that cancels your last one or more operations 

Redo:  A command that reinstates or receives an action performed or reverses an action performed by the Undo command

Repeat: A command that repeats only the last action you performed

Font Attributes 
-You can format the text in the document by changing the following font attributes:
· Font face or size
· Font attributes such as cold, underline, or italic
· Font colour
-Two methods provided for applying these font attributes:
· Choose the font attributes first and then type the text. The text displays in the document with the formatting 
· Type the text, select the text to format, and choose the font attributes. The selected text displays with the formatting 

Formatting Text: Changes an individual letter, a word, or a body of selected text

Font: Is a named set of characters within the same design 
 
Change the Font Size, Colour and Attributes
There are several places where these commands are easy access
· In the font group on the home tab
· On the Mini toolbar
· In the Font dialog box

Font Commands
Font: Enables you to designate the font
Font Size: Enables you to designate an exact font size
Grow Font: Each time you click the command; the selected text increases one size
Shrink font: Each time you click the command the selected text decrease one size
Clear formatting:  Removes all formatting from the selected text 
Bold: Makes the text darker than the surrounding text
Italic: Places the selected text in italic, that is slants the letters to the right
Underline: Places a line under the text. Click the Drop-down arrow to change the underline style 
Strike through: Draws a line through the middle of the text 
Subscript: Places selected text below the baseline
Superscript: Places selected text above the line of letters
Text highlight: Highlights text a different colour
Font colour: changes the colour of the font
Format Printer: Copies the formatting of text from one location to another 

Office 2007 Applications 
· A combination of four software applications
· You select the software that is appropriate for the task you wish to preform
· Word is used for document processing such as letters, memos, resumes and reports
· Focuses on manipulating text to create, edit and format documents. 
· Excel stores numeric data and performs calculations on this data
·  It can also create charts for a graphic view of the data
· Spreadsheets are used to create budgets, project payments for a mortgage or loan, and to analyze statistical information.
· Power point is a presentation software package.
· Presentations can be given by speakers, they can be self-presenting like those you might see in a kiosk, or they can consist of a web page presentation
Summary 
1. Identify common interface elements. You learned to identify and use the common elements of the Office 2007 interface and apply them in Word, PowerPoint, Excel, and Access. The top of the application window contains the Office Button that, when clicked, displays the Office menu. The Quick Access Toolbar provides commonly used commands, such as Save and Undo. The primary command center is the Ribbon, which contains tabs to organize major tasks. Each tab contains groups of related commands. The bottom of the window contains a status bar that gives general information, view options, and the Zoom slider. 
2. Use Office 2007 Help. When you need help to continue working with Office 2007, you can use the Help feature from your computer or get help at Microsoft Office Online. You can position the mouse pointer on a command to see an Enhanced ScreenTip. You can click some Enhanced ScreenTips to display help. You can get context-sensitive help by clicking Help within dialog boxes. 
3. Open a file. To retrieve a file you have previously saved, you use the Open command. When you open a file, it is copied into RAM so that you can view and work on it. 
4. Save a file. As you create and edit documents, you should save your work for future use. Use the Save or Save As command to save a file for the first time, giving it a name and location. To continue saving changes to the same filename, use Save. To assign a new name, location, or file type, use Save As. 
5. Print a document. Producing a perfect hard copy of the document is an important task, and you can make it easier by previewing, selecting options, and printing. You can select the printer, how many copies to print, and the pages you want to print. In addition, each program has specific print options. 
6. Select text to edit. In order to edit text, you have to identify the body of text you want to work with by selecting it first. You can select text by using the mouse. 
7. Insert text and change to the Overtype mode. To edit text in the document, you need to be able to insert text and to replace text by typing over it. The Insert mode inserts text without delet- ing existing text. The Overtype mode types over existing text as you type. 
8. Move and copy text. You can move text from one location to another to achieve a better flow in a document, worksheet, or presentation. You can use the Copy command to duplicate data in one location and use the Paste command to place the duplicate in another location. 
9. Find, Replace, and Go To text. Another editing feature that can save you time is to find text by searching for it or going directly to a specific element in the document. You can also replace text that needs updating. 
10. Use the Undo and Redo commands. If you make a mistake and want to undo it, you can easily remedy it by using the Undo feature. Likewise, to save time, you can repeat the last action with the Redo command. 
11. Use language tools. Office 2007 provides tools to help you create and edit error-free documents. You can use the spelling check and grammar check, the built-in thesaurus, and even conduct research all from your Word document. You can check spelling and conduct research in Excel and PowerPoint as well. 
12. Apply font attributes. Applying font formats can help make the message clearer. For example, you can select a different font to achieve a different look. In addition, you can adjust the font size and change the font color of text. Other font attributes include bold, underline, and italic. 
13. Copy formats with the Format Painter. You might want to copy the format of text to another loca- tion or to several locations in the document. You can easily accomplish that with the Format Painter. 





6.What will Word Processing do for me?
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Word Tabs
Home: The basic Word tab. Contains basic editing functions such as cut and paste along with most formatting actions. Some groups contain Dialog Box launchers that offer more commands and increase functionality.
 Clipboard, font, paragraphs, styles and editing 

Insert:  Brings together all insert functions in one area. Includes ability to create graphs and add tables. Contains powerful picture functions. Headers and footers are inserted here
 Pages, tables, illustration, links, header & footer, text and symbols

Page Layout: Contains all functions associated with page appearance, setup and printing. Provides features that facilitate documentation 
Themes, Page setup, page background, paragraph, Arrange 

References:  Provides functions for automating references in a document. Includes assistance using popular writing styles
 Table of contents, footnotes, citations & bibliography, captions, index and Table of Authorities

Mailings: Contains commands used in the process of combining data from multiple sources and providing useful information
Create, start Mail merge, write & Insert Fields, Preview results and finish

Review:  Contains all reviewing tools in word, including spelling and grammatical check, the management of comments, sharing and protection
 Proofing, comments, tracking, changes, compare and Protect

View: Contains basic and advanced views settings. Some of these options also appear below the horizontal scroll bars
 Document views, Show/Hide, Zoom, Window and macros

Word wrap: Moves words to the next line if they do not fit on the current line

Hard return: Is created when you press enter to move the insertion point to a new line 

Soft return: is created by the word processor as it wraps text to a new line
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Toggle switch: Is a device that causes the computer to alternate between two states

Show/hide feature:  Reveals where formatting marks such as spaces, tabs, and returns are sued in the document 
· The show/hide button reveals formatting
· Toggles on and off
· Off—how the document looks when printing
-On the Home ribbon in the paragraph group, select Show/Hide. Show/Hide is a toggle that allows background formatting information to be seen on-screen. This information does not print.
· All spaces are shown as dots.
· Non-breaking spaces are shown as small circles.
· Non-breaking hyphens are shown as longer hyphens, but they print like regular hyphens.
· Tabs are shown as arrows.
· A paragraph is all the text between two paragraph marks.
· Line breaks are shown as circular arrows.

Auto text:  Feature substitutes a predefined item for specific text but only when the user initiates it 
 AutoText contains predefined entries that Word suggests as a ScreenTip whenever the program identifies the possible beginning of an entry in its registry, such as the date shown above.

Building Blocks: Are document components used frequently, such as disclaimers, company addresses or a cover page
Produce personal AutoText entries through the building block dialog box.
· Highlight the text to be added and choose Quick Parts to open the Create New Building Block dialog box.
· Name the block and choose to place it in the AutoText gallery. Add the block to a category if appropriate.
· To use the Building Block, type the first part of the entry and then press F3.

Views: The different Kind of views 
The View buttons on the status bar are a collection of different ways to look at the document.
· Print Layout View, which shows a document as it will print. All printed portions of the document will be visible, including headers and footers.
· Full Screen Reading View is the view for reading on screen. This view reflows the document and only shows body text. Documents opened from the Internet are opened in full screen reading view.
· Web Layout shows the document as a web page.
· Master Document Tools View shows an outline based on the style heading that was used in the document. This view is also used when producing a Master document and subdocuments.
Draft View is similar to what was previously known as normal view. The body of the document without headers and footers is displayed. This view does not show page breaks unless they have been manually added.

Print Layout view: is the default view and closely resembles the printed document 

Full Screen Reading view: Eliminates tabs and makes it easier to read your document 

Draft View:  Shows a simplified work area, removing white space and other elements from view

Outline View: Displays a structural view of the document that can be collapsed or expanded 

Web Layout view: Is used when creating a web page 

Mini toolbar: Contains frequently used formatting commands and displays when you select text or right click

Margins:  Are the amount of white space around the top, bottom, left and right edges of the page 

Portrait Orientation:  Positions text parallel with the short side of the page 

Landscape Orientation: Positions texts parallel with the long side of the page

Soft page Break: Is inserted when text fills an entire page, then continues on the next page

Hard page Break: Forces the next part of a document to begin on a new page

Page numbers
-Use the page number button to add a page number field to the header or footer
- On the Insert ribbon in the Header & Footer group, select Page Number to insert a page number field into the header or footer.
- Format page numbers using Format Page Numbers from the menu. Choose a Number format. Include chapter (section) number if appropriate and set the numbering system to Continue from a previous section or choose a number to start at.

Header: Is information printed at the top of document pages

Footer: Is information printed at the bottom of document pages?
 To add go to the insert tab and choose either header or footer

Section Break:  Is a marker that divides a Document into sections, thereby allowing different formatting in each section 
- The section heading can do the following:
 Change the margins within a multipage letter, where the first page (the letterhead) requires a larger top margin than the other pages in the letter
 Change the orientation from portrait to landscape to accommodate a wide table at the end of the document 
 Change the page numbering to use Roman numerals at the beginning of the document for a table of contents and Arabic numerals thereafter
 Change the number of columns in a newsletter which may contain in the body of the newsletter

Find and replace
· Find a part of a document
· Replace unwanted text with something new in a document
· Replace All globally replaces unwanted text throughout the document
- On the Home tab in the Editing Group, select either Find or Replace. Both buttons open the same Find and Replace dialog box

Case-sensitive search: Matches not only the text but also the use of the upper- and lowercase letters

Case-insensitive search:  Finds a word regardless of any capitalization used

Selective replacement: Lets you decide whether to replace text 

Automatic replacement:  Makes substitution automatically

Spelling and Grammar: the feature that looks for mistakes in spelling, punctuation, writing style and word usage

Spelling and Grammar
· Questionable spelling is underlined in red
· Contextual spelling questions are underlined in blue
· Questionable grammar is underlined in green
- Squiggly lines under portions of text identify misspelled words or questionable grammar
- Click the Check grammar check box to check grammar as well as spelling.
- Word has a new contextual spelling engine which catches problem words that aren’t necessarily spelled wrong, but are used incorrectly

Compatibility Checker: Looks for features that are not supported by previous versions of word

Document Inspector:  Checks for and removes different kinds of hidden and personal information from a document
-Word provides inspectors that you can invoke to reveal different types of information including:
· Comments, Revisions, Versions and Annotations
· Document properties and personal information 
· Custom XML Data
· Headers, Footers and Watermarks 
· Hidden Text
Printing
· - To get to the print screen, click on the Office Button and choose Print, or type Ctrl+P on the keyboard to open the print screen.
· - Choose the printer from the drop-down list or find a printer on the network using the appropriate button on the dialog box.
· - Print multiple pages per sheet, only odd pages, or only even pages. Scale the document to print the document smaller.
· -Choose the pages to print (All, Current Page or choose a page range) and decide how many copies of the document to print. The default is 1.

Word options 
Popular: Change the most popular options in word
Display:  Change how documents are displayed on the screen and in print
Proofing: Modify how word corrects and formats your text 
Save: Customize how documents are saved
Advanced:  Specify editing options; cut, copy, and paste options; show document content options; display options; print options and save options
Customize: Customize the Quick Access Toolbar and other keyboard shortcuts
Add-ins: View the add-ins previously installed, customize settings for add-ins, and install more add-ins 
Trust center: View online documentation about security and privacy and change settings to protect documents from possible infections 
Resources: Provide links to Microsoft sites where you can find online resources and keep your office application updated
Summary 
1. Understand Word basics. A word processing window is made up of several components includ- ing the title bar, Quick Access Toolbar, status bar, and the document area. Several tabs con- tain the commands that you use while working in Word, and the tabs might change accord- ing to the current task. As you type in a document, the word wrap feature automatically positions text for you using soft returns; however, you can insert a hard return to force text to the next line. Toggle switches such as the Caps Lock key or Bold feature are often used to alternate between two states while you work. The Show/Hide ¶ feature toggles on to reveal formatting marks in a document. The AutoText feature enables you to quickly insert predefined text or graphics. 
2. Use AutoText. The AutoText feature substitutes a predefined item for specific text when the user initi- ates the replacement. Predefined and frequently used items, such as a logo, company name, author name, or return address, are stored as building blocks. You can type a portion of the building block entry, then press F3 to insert the remainder into your document. 
3. View a document. The View tab provides options that enable you to display a document in many different ways. Views include Print Layout, Full Screen Reading, Web Layout, Outline, and Draft. To quickly change the view, click a button on the status bar in the lower-right corner of the window. You can use the Zoom slider to very quickly change magnification by sliding to a different percentage such as 75%. The Zoom dialog box includes options to change to whole page or multipage view. 
4. Use the Mini toolbar. The Mini toolbar contains frequently used formatting commands such as Bold, Italic, Underline, Center, and Font Size. It displays faintly when you select text or right-click selected text, but it darkens as you move the mouse pointer closer to it. If you move the mouse pointer away from the Mini toolbar, it becomes fainter; if you do not want to use the Mini toolbar and prefer it disappears from view, press Esc when it displays. 
5. Set 
6. and specify page orientation. When you create a document, you should consider how it will look when you print or display it. Margins determine the amount of white space from the text to the edge of the page. Pages can be set to display in portrait or landscape ori- entation. In portrait orientation, the text runs parallel to the shorter side of the paper. In land- scape orientation, the text runs parallel to the longer side of the paper. 
7. Insert page breaks. Soft page breaks occur when text no longer fits on the current page and auto- matically wraps to the top of a new page. The break is signified by a hidden marker that you can view using the Show/Hide ¶ feature. Hard page breaks can be used to force text onto a new page. A hard page break is inserted into a document using the Breaks command in the Page Setup group on the Page Layout tab, or Page Break in the Pages group on the Insert tab, but more easily through the Ctrl+Enter keyboard shortcut. 
8. Add page numbers. Page numbers serve as a convenient reference point and assist in reading through a document. They can appear in the side margins, or at the top or bottom of a page, and can be left, center, or right aligned. The easiest way to place page numbers into a docu- ment is to click Page Number in the Header & Footer group on the Insert tab. When you use this feature, Word not only inserts page numbers but also adjusts automatically the page numbering when you add or delete pages. 
9. Insert headers and footers. Headers and footers give a professional appearance to a document and are the best location to store page numbers. A header consists of one or more lines that are printed at the top of a page. A footer is printed at the bottom of a page. Footers often contain the page number and the date the document was created. Headers might contain the name of an organization, author, or title of the document. Headers and footers are added from the Insert tab. A simple header or footer also is created automatically by the Insert Page Number command. 
10. Create sections. A section break is a marker that divides a document into sections, thereby allowing different formatting in each section. You determine where one section ends and another begins by using Breaks in the Page Setup group on the Page Layout tab. By using section breaks, you can change the margins within a multipage letter, where the first page (the letter- head) requires a larger top margin than the other pages in the letter. You also can change the page numbering within a document or even change the number of columns in a newsletter, which may contain a single column at the top of a page for the masthead, then two or three columns in the body of the newsletter.  
11. Insert a cover page. Word 2007 offers a feature to quickly insert a preformatted cover page in your document. The Cover Page feature includes a gallery with several designs, and each includes building block fields, such as Document Title, Company Name, Date, and Author, which you can personalize. 
12. Use the Find and Replace commands. Find and Replace commands include settings that enable you to look for or replace specific formatting on text. They also include options to conduct a case-sensitive or case-insensitive search. You can also use automatic replacement or selective replacement where you determine on an individual basis whether to replace the text or for- mat. You can search for formatting and special characters. The Go To command moves the insertion point to a designated location in the document. You can go to a page, a section, or specify the number of pages to move forward or backward. 
13. Check spelling and grammar. The grammar check feature looks for mistakes in punctuation, writ- ing style, and word usage. If it finds an error, it will underline it with a green wavy line. You also can ask the grammar check to explain the rule it is attempting to enforce. When a possi- ble error is found, you can accept the suggested correction, or determine if it is appropriate. The contextual spelling feature attempts to locate a word that is spelled correctly but used incorrectly. For example, it looks for the correct usage of the words there and their. A contex- tual spelling error is underlined with a blue wavy line. 
14. Use save and backup options. To prevent loss of data you should save and back up your work fre- quently. You also should be familiar with commands that enable you to save your documents in a format compatible with older versions of Microsoft Word. You can use the convert com- mand to alter those files into Word 2007 format, which is more efficient. Several backup options can be set, including an AutoRecover setting you can customize. This feature is useful for recovering a document when the program crashes. You can also require Word to create a backup copy in conjunction with every save operation. Word 2007 includes a compatibility checker to look for features that are not supported by previous versions of Word, and it also offers a Document Inspector that checks for and removes different kinds of hidden or per- sonal information from a document. 
15. Select printing options. You have three options to consider when you are ready to print your work: Print, Quick Print, and Print Preview. In the Print Preview window, you have several settings that enable you to magnify the page onscreen, display multiple pages, and even make changes to the page layout so you can view the results immediately. The Quick Print option sends a document straight to the printer without prompting you for changes to the printer configuration. The Print dialog box contains many useful options including print only the current page, a specific range of pages, or a specific number of copies. 
16. Customize Word. After installation, Word is useful immediately. However, many options can be customized. The Word Options dialog box contains nine categories of options you can change including Personalize, Proofing, and Add-Ins. You can add to or remove commands from the Quick Access Toolbar using the Customize section of the Word Options dialog box. 

7. Gaining Proficiency: Editing and Formatting 
Typography: Is the appearance of printed matter 
-Also knows as the process of selecting typefaces, type styles and type sizes

A Typeface or font: is a complete set of characters- upper- and lowercase letters, numbers, punctuation marks, and special symbols

Serif fontfaces have small features at the end of strokes within letters (times new roman). Contain a line at the top and bottom of letters. 
 traced back to the Romans 
The serifs, or feet, are remnants from original writing that was chiseled into stone

Sans-serif fontfaces (without serifs) are simpler and have no extra strokes on the ends of letters (Arial)
 More modern fonts but still very old, bolder 
-Two overall font groups  serif and sans-serif font families.

[image: ]
Monospaced typeface: Uses the same amount of horizontal space for every character

Proportional typeface:  Allocates horizontal space to the character 

[image: ]

Type Style: Is the characteristic applied to a font, such as bold
-Use bold (Ctrl+B) for emphasis, to highlight important points and to create contrast for headlines and subheadings
-Use italic (Ctrl+I) to create subtle emphasis and to set apart certain names and titles
[image: ]

Characters are the actual letters used to make words
To make character-level formatting, select the entire group of characters to which the format should be applied.

Paragraphs are the other building block of Word’s formatting process
Paragraph-level formatting applies to the entire paragraph and cannot apply to only part of a paragraph.

Change Case: is used to change the capitalization of the text

Sentence case:  Capitalizes only the first word of the sentence of phrase)

Lowercase:  Changes the text to lowercase

UPPER CASE:  Changed the text to all capital letters

Capitalize Each word: Capitalizes the first letter of each word; effective for formatting titles, but remember to lowercase first letters of short prepositions such as of

tOGGLE cASE: Changes lowercase to uppercase and uppercase to lowercase 

Font effects 
· Effects available for fonts include strikethrough, superscript, subscript, shadow, emboss, engrave, and small caps.
· Strikethrough Displays a horizontal line through the middle of the text 
· Superscript shrinks the font size and raises the letter off the baseline. This can be used for items like 23rd, 28th, or a footnote/endnote.
· Subscript also shrinks the font size, but lowers the letter; for example, a molecular structure H2O (water)
· Shadow, Emboss and Engrave are specialized options that should be reserved for only very limited purposes.
· Shadow adds a drop shadow to the text. This is supposed to make the text look like it is floating off the paper.
· Emboss: Displays text as if it has been raised from the page
· Engrave: Displays text as if it has been pressed down intot he page
· Smallcaps : Displays letters as uppercase but smaller than regular-sized uppercase letters

Hidden text: Does not appear onscreen 
-Unless you click the show/hide

Character spacing: is the horizontal space between characters

Scale:  Increases or decreases text as a percentage of its size

Position: Raises or lowers text from the baseline

Kerning: allows more even spacing between characters 

Highlighting text is a button on the font menu that adds background shading to the text selected.

Nonbreaking Hyphen: Prevents a word from becoming separated at the hyphen

Nonbreaking space:  Keeps two or more words together on a line

Format Painter: copies existing text formulas to other text 
· great tool to use to make format changes across the entire document.

Tabs: Are markers for aligning text in a document

Left tab: Marks the position to align text on the left

Center tab: Marks where text centers as you type

Right tab: marks the position to align text on the right

Decimal tab: Marks where numbers align on a decimal point as you type

Bar tab: arks the location of a vertical line between columns

Leader Character: Is dots or hyphens that connect two items
** Table of Contents

Border: Is a line that surrounds a paragraph, a page, a table, or an image

Shading: is a background color that appears behind text 

Create bulleted and numbered lists
Bulleted list:  Itemizes and separates paragraph text to increase readability 

Numbered list:  sequins and prioritizes items 

Multilevel list:  Extends a numbered list to several lines 

Columns:  Format a section of a document into side-by-side vertical blocks
-The columns dialog box provides options for setting the number of columns and spacing between columns. 

Applying Paragraph formats
Horizontal Alignment: Refers to the placement of the text between the left and right margins
-Alignment options are justified (flush left/ flush right), left aligned (flush left with a ragged right margin), right aligned (flush right with a ragged left margin), or centered with the margins (ragged left and right). 
-The default alignment is left

Paragraph: Preventing Awkward Breaks
· Widow/Orphan control prevents single words and partial words at the end of a paragraph from continuing on their own line
· Keep with next will keep the paragraph with the next one. Use this to keep headings with the first paragraph below
· Keep lines together keeps lines in a paragraph together
· Page break before will start a paragraph on its own page

· Paragraphs can end awkwardly. To keep this from happening automatically, use the Line and Page Breaks tab in the Paragraph dialog box.
· [image: ]Widow/Orphan control keeps single words and partial words from ending on their own lines or worse yet, from ending on a new page. When this is checked, Word will move at least two words to the new line at the end of a paragraph. If it has to move a line to a new page, it will take two lines. This makes the document look more professional.
· Keep with next needs to be used when a heading is set up in a document. When this is selected for the paragraph, it moves with the paragraph below to a new page. This ensures that headlines are above the correct text.
· Keep lines together is similar, but this can be used to keep lines together no matter what. This would be a perfect choice to apply to a multi-lined address in a document.
· Finally, Page break before might be added to a heading that acts as if it were a section or chapter title. This forces the heading to start on a new page.

First line indent: Marks the location to indent only the first line in a paragraph 

Hanging indent: Marks how far to indent each line of a paragraph except the first 
-Often used for bullet or numbered lists and bibliography pages

Line Spacing: is the space between the lines in a paragraph 
-Controls all spacing within and between paragraphs

Paragraph spacing: Is the amount of space before or after a paragraph 
-Paragraph dialog box

Window: is the last line of a paragraph appearing by itself at the top of a page

Orphan: is the first line of a paragraph appearing by itself at the bottom of a page

 Styles and Document References
Style: is a set of formatting options you apply to characters or paragraphs 
-Automate the formatting process and provide a consistent appearance to a document 

Character style:  Stores character formatting and affects only selected text (font, size and style)

Paragraph style: Stores paragraph formatting of text (Alignment, line spacing, indents, tabs, text flow and borders and shading, as well as the font size and style of the text in paragraph)

Autoformat: Feature analyzes a document and formats for you 
Outline view: is a structural view that displays varying amounts of detail. 
Table of contents: lists headings and the page numbers where they appear in a document 

Index:  Is a listings of topics and the page numbers where the topics is discussed 

Summary 
1. Apply font attributes through the Font dialog box. Formatting occurs at the character, para- graph, or section level. The Font dialog box allows you to change spacing of the characters and also provides special formatting options for text that only appears on the screen. Through this dialog box, you can change the font and character spacing attributes includ- ing font, font size, font color, underline color, and effects. Use the character spacing options to control horizontal spacing between letters. You also can adjust the scale, position, and kerning of characters. 
2. Highlight text. The Text Highlight Color command provides the ability to color text on screen so it stands out or resembles highlighting marks you often make in books. The Text Highlight Color command is located on the Home tab and also on the Mini toolbar that appears when you select text. 
3. Control word-wrapping with nonbreaking hyphens and nonbreaking spaces. Occasionally, text wraps in an undesirable location in your document, or you just want to keep words together for better readability. To keep hyphenated words together on one line, use a non- breaking hyphen to replace the regular hyphen. You insert a nonbreaking hyphen by pressing Ctrl+Shift+Hyphen in place of a hypen. You also can keep words together on one line by inserting a nonbreaking space instead of using the spacebar. To insert a nonbreaking space click Ctrl+Shift+Spacebar. 
4. Copy formats with the Format Painter. Use the Format Painter to copy existing format features to other text for consistency in appearance. The Format Painter uses fewer clicks than format- ting from scratch. You can use it one time by single-clicking Format Painter in the Clipboard group on the Home tab, then selecting the text to format. If you double-click Format Painter, it toggles on and you can select many items to format the text. To toggle off the Format Painter, press Esc or click Format Painter again. 
5. Set off paragraphs with tabs, borders, lists, and columns. You can change the appearance and add interest to documents by using paragraph formatting options. Tabs allow you to set markers in the document to use for aligning text. Borders and shading are set at the character or paragraph level and enable you to use boxes and/or shading to highlight an area of your document. A bulleted or numbered list helps to organize information by emphasizing and/or ordering important topics. Columns add interest to a document by formatting text into side- by-side vertical blocks of text and are implemented at the section level. 
6. Apply paragraph formats. You can use additional formatting options in the Paragraph dialog box. Paragraph alignment refers to the placement of text between the left and right margins; text can be aligned left, right, centered between, or justified, which allows it to touch both mar- gins. Another option that incorporates the distance from margins is indention. You can spec- ify indention from the left margin, right margin, or both, or use special indents such as hang- ing or first-line. Line spacing determines the space between lines in a document and can be customized as single, double, or 1.5, for example. You also can specify an amount of space to insert before or after a paragraph, which is more efficient than pressing Enter. Widow/Orphan control prevents a single line from displaying at the top or bottom of a page, separate from the rest of a paragraph. 
7. Create and modify styles. A style is a set of formatting instructions that has been saved under a dis- tinct name. Styles are created at the character or paragraph level and provide a consistent appearance to similar elements throughout a document. You can modify any existing style to change the formatting of all text defined by that style. You can even create a new style for use in the current or any other document. Styles provide the foundation to use other tools such as out- lines and the table of contents. The Outline view displays a condensed view of a document based on styles within the document. Text may be collapsed or expanded as necessary to facili- tate moving text within long documents. The Outline view does not display a conventional out- line, which is created in Print Layout view using the Multilevel List command on the Home tab. 
8. Create a table of contents. A table of contents lists headings in the order they appear in a docu- ment with their respective page numbers. Word can create it automatically, provided the built-in heading styles were applied previously to the items for inclusion. 
9. Create an index. Word also will create an index automatically, provided that the entries for the index have been marked previously. This result, in turn, requires you to go through a docu- ment, select the appropriate text, and mark the entries accordingly. 
8. Enhancing a document: Tables and Graphics 
Tables
Tables:  is a series of columns and rows that organize data

Cell: Is the intersection of the column and row in a table 
-To insert a table go to the insert tab to see a gallery of cells from which you select the number of columns and rows you require in the table, or you can choose the insert table command below the gallery to display the Insert table dialog box and enter the table composition you prefer
-The insert and delete commands allow you to insert and delete columns
-The Merge Cells command allows you to join individual cells together (merge) to form a larger cell

Row Height:  is the vertical space fro the top to the bottom of a row

Column width: Is the horizontal space or length of a column

Table tools layout Ribbon 
Table 
-Select particular parts of a table (entire table, column, row, or cell)
-Show or hide the guidelines around the table
-Display the Table properties dialog box to format the table 

Rows & Columns
-Delete cells, columns, rows, or the entire table
-Insert rows and columns
-Display the insert Cells Dialog box

Merge
-Merge (join) selected cells together 
-Split cells into additional cells 
-Split the table into two tables 

Cell Size
-Adjust the row height and column width
-Adjust the column width automatically based on the data in the column
-Display the Table properties dialog box

Alignment
 -Specify the combined horizontal and vertical alignment of text within a cell 
-Change the text direction 
-Set margins within a cell

Data
-Start data within a table
-Repeat heading rows when tables span multiple pages 
-Convert tabulated text to table format 
-Insert a formula in a table

Advanced Table features
Shading:  Affects the background colour within a cell

Border:  Refers to the line style around each cell

Table style: Contains boarders, shading and other attributes to enhance a table 

Table Alignment: Is the position of a table between the left and right margins 

Text direction: Refers to the degree of rotation in which text displays

Cell margins: Are the amount of space between data and the cell border in a table 

Sorting and applying formulas to a table data
Sorting: Is the process of rearranging data

Sort Data in a table
Ascending order: Arranges data from lowest to highest 

Descending order: Arranges Data from highest to lowest 
 Under the layout tab click the start dialog box

Table tools Design Ribbon
Table Style Options
-Turn Header Row On or Off
-Turn Total Row On or Off
-Display banded rows; formats even and odd numbered rows differently 
-Display special formatting for first column
-Display special formatting for last column
-Display banded columns; formats even and odd numbers columns differently

Table Styles
-Select predefined style from gallery 
-Apply color behind the selected cells or table 
-Customize borders of selected cells or table 

Draw boarders
-Alter style of line used around border of cell of table 
-Alter size used for borders
-Change color of pen feature; use with Draw Table feature
-Manually draw border of cells or table 
-Erase borders of cells or table
-Display the borders and Shading dialog box

Graphic tools
Clip Art: a graphical image, illustration, drawing or sketch
-After inserting clips art or images from cameras or web, you can adjust size choose placement, and preform other graphical format options

Copyright: provides legal protection to a written or artistic work

Microsoft Clip organizer:  Catalogs pictures, sounds, and movies stored on your hard drive

Sizing handles: Are the small circles and squares that appear around a selected object and enable you to adjust the height and width of an object 

Text wrapping style: Refers to the way text wraps around an image
Picture Styles: gallery contains preformatted options that can be applied to a graphi- cal object. 

Text wrapping styles
Square: Allows text to wrap around the graphic frame that surrounds the image

Tight: Allows text to wrap tightly around the outer edges of the image itself instead of the frame 

Through:  Select this option to wrap text around the perimeter and inside any open portions of the object 

Top and Bottom: Text wraps to the top and bottom of the image frame but no text appears on the sides

Behind Text:  Allows the image to display behind the text in such a ways that the image appears to float directly behind the text and does not move if text is inserted or deleted

In Front of Text:  Allows the image ti display on top of the text in such a way that the image appears to float directly on top of the text and does not move if text is inserted or deleted

In line with text:  Graphic displays on the line where inserted so that as you add or delete text, causing the line of text to move, the images move with it 

The Picture styles:  Gallery contains preformatted options that can be applied to a graphical object 
-Quick styles provide a valuable resource if you want to improve the appearance of a graphic but are not familiar with graphic design and format tools

Adjusting Graphics
Crop or cropping: is the process of trimming the edges of an image or other graphical object
Cropping tool is located in the size group on the Format tab

Scale or Scaling:  is the adjustment of height or width by a percentage of the images original size

Contrast: Is the difference between light and dark areas of an image 
 Increases or decreases the difference in dark and light areas of the image 

Brightness:  Is the ratio between lightness and darkness of an image 
 Lightens and darkens the overall image 

Compress: Reduces the file size of an object

Graphic editing features chart
Height height of an object in inches
Width Width of object in inches
Crop Remove unwanted portions of the object from top, bot- tom, left, or right to adjust size.
Align Adjust edges of object to line up on right or left margin or center between margins.
Group Process of selecting multiple objects so you can move and format them together.
Rotate  Ability to change the position of an object by rotating it around its own center
Text wrapping  Refers to the way text wraps around an object 
Position Specify location on page where object will reside
Border The outline surrounding an object; it can be formatted using colour, shapes, or width, or can be set as invisible 
Shadow Effects Ability to add a shadow to an object 
Compress Reduce the file size of an object 
Brightness Increase or decrease brightness of an object
Contrast  increase of decrease difference between black and white colors in an object 
Recolor Change object to give it an effect such as washed-out or grayscale 

Microsoft WordArt:  Creates decorative text for a document

Inserting symbols into a document
-The Symbol command enables you to enter typographic symbols and/or foreign lan- guage characters into a document in place of ordinary typing—for example, ® rather than (R), © rather than (c), 1/2 and 1⁄4, rather than 1/2 and 1/4, or é rather than e (as used in the word résumé).
-These special characters give a document a very professional look 
Summary 
1. Insertatable.TablesrepresentaverypowerfulcapabilitywithinWordandareusedtoorganizea variety of data in documents. The Table command is on the Insert tab, and tables are made up of rows and columns; the intersection of a row and column is called a cell. You can insert additional rows and columns if you need to add more data to a table, or you can delete a row or column if you no longer need data in the respective row or column. Individual cells can be merged to create a larger cell. Conversely, you can split a single cell into multiple cells. The rows in a table can be different heights and/or each column can be a different width. 
2. Formatatable.Eachcellinatableisformattedindependentlyandmaycontaintext,numbers, and/or graphics. To enhance readability of table data, you can apply a predefined style, which Word provides, or use Borders and Shading tools to add color and enhance it. Furthermore, you can align table data—at the left margin, at the right margin, or centered between the margins. You also can change the text direction within a cell. 
3. Sortandapplyformulastotabledata.Youcansorttherowsinatabletodisplaythedatain ascending or descending sequence, according to the values in one or more columns in the table. Sorting is accomplished by selecting the rows within the table that are to be sorted, then executing the Sort command in on the Layout tab. Calculations can be performed within a table using the Formula command in that same tab. 
4. Converttexttoatable.Ifyouhavealistoftabulateditemsthatwouldbeeasiertomanipulateina table, you can use the Convert Text to Table command. The command also works in reverse, enabling you to remove data from a table and format it as tabulated text. 
5. Insertclipartandimagesintoadocument.Youoftenaddgraphicstoenhanceadocument. When you click the Clip Art command, Office displays a task pane where you enter a key- word to describe the clip you are looking for. The search is made possible by the Microsoft Clip Organizer, which organizes the media files available to you into collections, then enables you to limit the search to specific media types and/or specific collections. Resources (such as clip art or photographs) can be downloaded from the Web for inclusion in a Word document. Although clip art is often acceptable for educational or nonprofit use, it may not be permitted in some advertising situations. You should always assume a graphic is copyrighted unless noted otherwise. 
6. Formatagraphicelement.Afteryouinserttheclipartobject,youcanuseavarietyoftoolsto refine the object to fit in your document, such as changing height and width, cropping, rotat- ing, or aligning. 
7. InsertWordArtintoadocument.MicrosoftWordArtisanapplicationwithinMicrosoftOfficethat creates decorative text that can be used to add interest to a document. WordArt can be used in addition to clip art or in place of clip art if the right image is not available. You can rotate text in any direction, add three-dimensional effects, display the text vertically down the page, or print it upside down. 
8. [bookmark: _GoBack]Insertsymbolsintoadocument.TheInsertSymbolcommandprovidesaccesstospecialcharac- ters, making it easy to place typographic characters into a document. The symbols can be taken from any font and can be displayed in any point size. 
10.Introduction to Excel: What can I do with a Spreadsheet
Spreadsheet: The computerized equivalent of ledger, contains rows and columns of data
-It is a grid of rows and columns enabling users to organize data, recalculate results for cells containing formulas when any data in input cells change, and make decisions based on quantitative data 
-Spreadsheet program: Is a computer application designed to build and manipulate spreadsheets  Microsoft Excel
Worksheet: Is a spreadsheet that may contain formulas, functions, values, text and graphics
Workbook: Is a file containing related worksheets
 Teacher creating a workbook of worksheets for each class they teach 
Planning for good workbook and worksheet design
· Plan before you start entering data
· Steps to ensure a good design:
Decide on the purpose of the spreadsheet and how it will be constructed
Make it obvious where data is to be entered
Enter data and set up formulas wherever possible
Allow Excel to do what it was designed for – automatic calculation
-Steps to ensure good design include:
Deciding on the purpose of the spreadsheet and how it will be constructed.
Making it obvious where data is to be entered.
Entering data and setting up formulas wherever possible.
Planning for good workbook and worksheet design (continued) 
· Test multiple times to make sure the results are what you expect
Know what your results should be so that you know your result is correct
· Format the worksheet so it looks appealing
· Document the worksheet as thoroughly as possible
Save and print the results

Active Cell: Is the cell you are working in, the cell where information or data will be input
Formula Bar: Is used to enter or edit cell contents
Name box: Indicates the location or name for the active cell
Sheet tabs: Tell the user what sheets of a workbook are available 
Select All Button: is clicked to select all elements of the worksheet
Excel Tabs (Most same as word) 
Home: The basic Word tab. Contains basic editing functions such as cut and paste along with most formatting actions. Some groups contain Dialog Box launchers that offer more commands and increase functionality.
 Clipboard, font, editing, Alignment, Number, Style, Cells 
Insert:  Brings together all insert functions in one area. Includes ability to create graphs and add tables. Contains powerful picture functions. Headers and footers are inserted here
 Tables, illustration, links, charts, texts
Page Layout: Contains all functions associated with page appearance, setup and printing. Provides features that facilitate documentation 
Themes, Page setup, Arrange, Scale to fit, sheet options
***Formulas: The area that contains the mathematical backbone of Excel. Includes basic areas (function Library) as well as more advanced (formula Auditing)
 Function Library, defined names, formula Auditing, calculation
***Data: The heart of the database portions of Excel. While not a true relational database, it has much power and includes Goal Seek scenario Manager 
 Get External Data, Connections, Sort & filter, Data Tools, outline
Review:  Contains all reviewing tools in Excel, including spelling and grammatical check, the management of comments, sharing and protection
 Proofing, comments, changes
View: Contains basic and advanced views settings. Some of these options also appear below the horizontal scroll bars
 Document views, Show/Hide, Zoom, Window and macros
Identifying Columns, rows and cells
-A spreadsheet is divided into columns and rows, with each column and row assigned a heading
Cell: Is the intersection of a column and row
Cell reference: Is designed by a column letter and a row number 
 Example=  The cell at the intersection of column A and row 9 is A9
Entering and Editing Data in Cells
Text: Is any combination of entries from the keyboard and includes letters, numbers, symbols, and spaces 
Value: Is a number that represent a quantity, an amount, a date, or time
Formula: Is a combination of numbers, cell references, operators, and/or functions displayed in a calculation result 
Edit Data in a cell
-Three most common methods to edit data in a cell:
1.Select the cell you want to edit, click on the Formula Bar, make changes, press Enter
2.Double-click on the cell to be edited, make the changes, press Enter
3.Select the cell, press the F2 key, make the changes, press Enter
-Two options to clear the contents of the cell:
1. Click on the cell and delete it
2. Click on the Clear arrow in the Editing group on the Home tab
Mathematical Operations and formulas
-Mathematical operations are the backbone of Excel
-Formulas are used to perform mathematical operations and arrive at a calculated result
-Must begin with an equals (=) sign
-Used to automate calculations that were performed manually
-The basis of Excel is the performance of mathematical operations. For example, if you want to calculate the sum of contents of the cells C2 and C3 in Cell C4, you would do the following:
Click in cell C4 and type an = sign
Click on cell C2 and type a + sign
Click on cell C3 and press Enter
-Operator symbols include:
Addition (+), Subtraction (-), Multiplication (*), Division (/) and Exponentiation (^)
Insert/Delete Rows or Columns
-Due to modifications required in a worksheet, rows and columns may need to be inserted
-To insert a new row Click on the row number below where you want the new row inserted
-To insert a new column Click on the column letter to the right of where you want the new column inserted
-Click the Insert pull-down arrow on the Cells group on the Home tab Select Insert Sheet Rows or Insert Sheet Columns 

Order of precedence: Controls the sequences in which arithmetic operations are preformed, which affects the result 

Range: Is a rectangular group of cells
-Maybe as small as a single cell or as large as the entire worksheet
-Every command in Excel applies to a rectangular group of cells known as a range 

Move Operation: Transfers the content of a cell or cell range from one location to another, with the cells where the move originated becoming empty 
-The cell references within formulas are not changed when a cell containing a formula is moved. But excel does adjust all of the cells making up the formula when a cell containing a formula is moved
-You can use the drag drop method or cut and paste
-Cut and paste:
1. Select the range of cells to be  moved 
2.Pick cut in the clipboard group on the home tab
3. Select the range the cells will be moved to
4. Click pastes in the clipboard group in the home tab 
Delete operation:  Removes all content from a cell or for a selected cell range 

Auto fill: Enables you to copy the content of a cell or a range of cells by dragging the fill handle over an adjusted cell or range of cells
Example: If you enter January in a cell you can use auto fill to enter the rest of the months of a year 
Fill Handle: Is a small black square appearing in the bottom right corner of a cell 

Change worksheet tab colour
1. Right-click the Sheet1 tab
2. Select Tab colour
3. You select theme colours, standard colours, no colour or more colours 
Merge and center cells:  Option centers an entry across a range of selected cells
-Example: If you want to place a title at the top of a worksheet and center it over the material contained in the worksheet
-To merge cells and center a title across columns A through L you would:
1. Enter the title in cell A1
2. Select cells A1:L1
3. Click Merge & Center in the Alignment group on the Home tab 
AutoFit: Automatically adjusts the height and width of cells
-Changes the column width of the selected columns to fit the contents of the column 

Format Cells: operation controls formatting for numbers, alignment, fonts, borders, colours and patterns 
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Managing cell comments
· Adds documentation to the cell
· Used to clarify thoughts and define formulas
· A red triangle appears in the cell containing the comment
· The comment is visible when you point at the cell
To create a cell comment:
1.Click the cell requiring a comment.
2.On the Review tab, in the Comments group, click New Comment.
3.Enter the comment.
4.Click any other cell to complete the process.
5. Or right-click on the cell requiring a comment and select Insert Comment from the Shortcut menu.
11. Formulas and Functions: Math Basics for spreadsheet Use
· Formulas are used to perform mathematical operations and arrive at a calculated result
· Must begin with an equals (=) sign
· Contain mathematical operators
· Used to automate calculations that were once performed manually
- Formulas consist of a combination of constants, cell references and arithmetic. The equal sign within Excel indicates that a mathematical calculation is about to begin.

Creating a formula
Pointing: Uses the mouse or arrow keys to select the cell directly when creating a formula
To use this technique:
1. Click on the cell where the formula will be entered
2. Type an equal sign (=) to start a formula 
3. Click on the cell with the value to be entered in the formula 
4. Type a mathematical operator 
5. Continue clicking on cells and typing operators to finish the formula 
6. Press enter to completre the formula 
Fill handle: Is a small black square in the bottom-right corner of a selected cell
 To use this technique:
1. Click on the cell (or drag through the cells) to be copied 
2. Position the mouse pointer directly over the fill handle on the cell or cells to be copied. The pointer changes to thin crosshair
3. Click and hold down the left mouse button while dragging over the destination cells. Note that using the fill handle only works with contiguous or adjacent cells
4. Release the mouse button. If the cell to be copied contained a formula, the formula is copied, the cell references are changes appropriately, and Excel performs the calculations 

Relative cell reference: is a typical cell reference that changes when copied
-It is expressed in the form column letter, row number (C13) and is adjusted or changes according to the direction and relative distance it is copied
Absolute cell reference: indicated by dollar signs before the column letter and row number, stays the same regardless of where a formula is copied
-Appears with dollar signs before both the column letter and row number ($C$13)
-Example Pay roll spreadsheet that includes a calculation for state income tax using a constant tax rate 
Mixed cell reference: Combines an absolute reference with a relative reference ($C13)
-As a result, either the row number or column letter does not change when the cell is copied
Functions 
Functions: Is a preconstructed formula that makes difficult computations less complicated
-To insert a function use the insert function dialog box
Sum Function: Represented by Σ or sigma, adds up or sums the numeric entries within a range of cells
 Syntax: Refers to the rules for constructing the function 
Arguments: Are values as input that preform an indicated calculation, and then return another value as output
Table: Function category and Descriptions
Cube: Works with mulit-dimensional data stored on an SQL server
Database: Analyzes data stored in Excel
Date & Time: Works with dates and Time
Financial: Works with financial-related data
Information: Determines what type of data is in a cell
Logical: Calculated yes/no answers
Lookup and Reference: Provides answers after searching a table
Math and Trigonometry:  Performs standard math and trig functions
Statistical: Calculated standard statistical functions
Text: Analyzes Labels 
Using AutoSum 
· Automates the SUM function
· Click the cell where you want the result
· Click the AutoSum button
· Select the range of cells you want to sum
· Press Enter to complete
· An example of AutoSum:
=Sum(C4:C10) represents the sum of all the cells in the cell range C4 to C10
Average Function: Calculates the arithmetic mean, or average, for the values in an argument list  AVERAGE
-Can be used for such calculations as the average of several scores on a test or the average score for a number of rounds of golf
MIN function:  Determines the smallest value of all cell in a list of arguments MIN
- For the lowest score on a test
Max Function: Determines the highest value of all cells in a list of arguments MAX
-For highest mark on test
Count Function: Counts the number of cells in a range that contain numerical data  COUNT (Can be shown as =COUNT(C6:C24)
Counta Function:  Counts the number of cells in a range that are not blank COUNTA
Median Function:  Find the midpoint in a set of values  MEDIAN
-What ½ of the population is above of below
Today Function: Displays the current date in a cell  TODAY
-Shown as =TODAY()
Now Function: Uses the computer’s clock to display the current date and time side by side in a cell NOW
Lookup functions
IF function: is the most basic logical function in that it returns one value when a condition is met and returns another value when the condition is not met
-Has three arguments:
1.A condition tested to determine if it is true or false
2.The resulting value if the condition is true
3.The resulting value if the condition is false
=IF(condition,value_if_true,value_if_false)
VLOOKUP: Allows the Excel user to look up an answer from a table of possible answers
-Has three arguments:
1. A lookup value stored in a cell
2. A range of cells containing a lookup table
3. The number of the column within the lookup table that contains the value to
Financial Functions 
PMT: Calculates the payment on a loan 
-Has three arguments:
1.The interest rate per period
2.The number of periods
3.The amount of the loan
FV: Returns the future value of an investment
-Has three arguments:
1. The interest rate (also called the rate of return)
2. The number of periods (how long you will pay into the investment)
3. The periodic investment (how much you will invest per year)
Lookup Value: is the value to look up in a reference table
Lookup Table: Is a range of cells containing the reference table
Column index number: is the column number in the lookup table that contains return values 
Breakpoint: Is the lowest numeric value for a category or series in a lookup table to produce a corresponding result for a lookup function 
12.Charts: Delivering a Message
Chart: is a graphic representation of data
Choosing a Chart Type
· Graphic representation of data
· Attractive, clear way to convey information
· Select the type of chart that best presents your message
Add enhancements to better communicate your information
Data point: Is a numeric value that describes a single item on the chart
 Database sales for a company 
Data Series: Is a group of related data points
Collection of data points for four different cities
Category label:  Describes a group of data points in a chart
Textual information, such as column and row headings (cities, months, years, product names, etc.)

Column Chart: Displays data comparisons vertically in columns (Bar graph)
X or horizontal axis: Depicts categorical labels
Y or vertical axis: Depicts numerical values
Plot area: Contains graphical representation of values in data series
Chart Area: Contains the entire chart and all of its elements
Multiple data series: Compares two or more sets of data in one chart
 Involves the use of clustered column charts
Clustered column chart:  Groups similar data in columns, making visual comparison easier to determine (More the on bar side by side… red, green blue) 
-The choice of clustered versus stacked column depends on the intended message 
Stacked column chart: Places (stacks) data in one column with each data series a different color for each category 
Legend: Identifies the format or colour of each data series (bar chart with like bars on bars)
Bar Chart: Is a column chart that has been given a horizontal orientation
Pie chart: Displays proportional relationships
-Type of chart to select whenever words like percentage or market share appear in thr message delivered
-The pie or complete circle, donates the total amount 
Expanded Pie Chart:  Separates one or more slices of pic chart for emphasis
Three-dimensional pie chart: Is a pie chart that contains a three-dimensional view
Line chart: Uses a line to connect data points in order to show trends over a long period of time
Doughnut chart: Displays values as percentages of the whole
-Can display more than one series of data, and it has a hole in the middle 
Scatter (xy) chart: Shows a relationship between two variables
-(Dotted line graph)
-To show relationships between two different types of data
Stock Chart:  Shows the high, low and close prices for individual stocks over a period of time
Creating a Chart
1. Specify the data series
2. Select the range of cells to chart
3. Select the chart type
4. Insert the chart and design the chart location
5. Choose chart options 
6. Change the chart location and size

Six steps
-Specify the data series
The rows and/or columns that contain the data you want to chart
-Select the range to chart
Can be a single cell, but most often consists of multiple cells
Cells may be adjacent or non-adjacent
Use the Shift key to select adjacent cells; use the Ctrl key to select non-adjacent cells
-The most common mistake users make is that they don't think about the data they want to plot and how they want it to be presented. 
-Select the chart type
Each type presents data in a different way
Pick the type that will best illustrate the information you want to convey
-The type of chart you choose will determine how well the information will be conveyed
-Insert chart and designate location
-Insert as an embedded object in the worksheet
· You can print the worksheet and the chart on one page
-Insert the chart as a New Sheet
· You will be required to print the worksheet and chart on separate pages
-Choose chart options using the Design, Layout and Format tabs
· The Design tab can be used to display data in rows or columns
· The Layout tab can be used to change the display of chart elements
· The Format tab can be used to apply special effects
To change the chart location and size
· Select the chart to reveal sizing handles
Drag the sizing handles to achieve desired location and size
Table: Cell selection techniques
A single Cell  Click the cell, or press the arrow keys to move to the cell. 
A range of cells Click the first cell in the range, and then drag to the last cell, or hold down Shift while you press the arrow keys to extend the selection. 
A large Range of cells Click the first cell in the range, and then hold down Shift while you click the last cell in the range. You can scroll to make the last cell visible. 
All Cells on a worksheet click the select all button
Nonadjacent cells or cell ranges Select the first cell or range of cells, and then hold down Ctrl while you select the other cells or ranges. 
An entire row or column Click the row or column heading 
Adjacent rows or columns Drag across the row or column headings. Or select the first row or column, and then hold down shift while you select the last row or column
Noncontiguous rows or columns Click the column or row heading of the first row or column in your selection, then hold down Ctrl while you click the column or row headings of other rows or columns that you want to add to the selection.
Table: Chart types and purposes
Column: Compares, shows changes over time
Bar: Shows comparison between independent variables. Not used for time and dates
Pie: Shows percentages of a whole. Exploded pie emphasizes a popular category 
Line: Shows change in a series over categories or time
Doughnut: Compares how two or more series contribute to the whole
Scatter: Shows correlation between two sets of values
Stock: Shows high-low stock prices 
Chart tools 
Insert Contains all of the insert functions in one area, as well as powerful picture functions. Includes the ability to create charts and add tables. Headers and footers are inserted here.
Design Contains the basic design functions that are used with charts. Allows the changing of chart types and a handy area to change the layout of charts. An extensive gallery for chart styles is here along with the command to place a chart on a separate sheet.
Layout Contains extensive coverage of layout functions for charts. This tab contains another option for adding shapes and also areas to change label elements and both axes and gridlines. The analysis group is essential in advanced charting
Format Contains a wide variety of quick formatting tools. The shape styles and WordArt styles contain handy tools to quickly format those elements in charts. The Arrange items are valuable when working with text boxes and shapes.
Data Label:  Is the value or name of data point
13. Working with large Worksheets and Tables: Manipulating Worksheets and Table Management
Freezing: Is the process of keeping headings on the screen at all times 
-When you scroll to parts of a worksheet not initially visible, some rows and columns disappear from view. It is sometimes valuable to be able to view row and column headings no matter where you scroll
-Rows and columns that were not previously visible are not visible and so are the row and column headings
Hiding and unhiding Rows, Columns and Worksheets
Hidden: Is the state of rows, columns and sheets being invisible
-The hiding of these items in a worksheet is a common practice and is done for a variety of reasons Make other columns visible, conceal nonessential information or infor not needed at that time, hide personal data such as SIN numbers
-Hiding is not a delete command
- To hide a particular row or column in a worksheet:
1. Select the row or column to be hidden.
2. Click the Home tab.
3. Open the Format menu in the Cells group and select Hide or Unhide. Select the appropriate hide option.
To hide a worksheet:
1. Click on the sheet to make it active.
2. Click the Home tab.
3. Open the Format menu in the Cells group and select Hide and Unhide. Select Hide Sheet.
Locking cells
- Allows you to prevent viewers of your worksheet from making any changes to the cells 
- Possibly to lock data on a Payroll sheet
-On a protected sheet
-When lock is on no data can be entered
-When lock is off data can be entered
On a unprotected sheet
-When lock property is on data can be entered
-When lock property is off data can be entered
To protect/unprotect a worksheet
-The process of protecting a worksheet can be a two-step process, because the protection can allow to only preform functions in the spreadsheet or allow users to only preform certain functions in certain cells
 Click the Home tab and open the format menu in the Cells group
To protect work book go to review tab click protect workbook in changes group
Printing
Page break preview: Shows where page breaks occur and gives you the opportunity to change where the page breaks
Page Orientation
-Printing an entire worksheet on a single page is more efficient
-This can be accomplished by changing the page orientation
-Page orientation can be either Portrait (tall) or Landscape (wide)
-To change page orientation to print more of a worksheet on a page:
· Click Orientation on the Page Layout tab
· Select Portrait or Landscape
Print a Selection
-You may want to print only a portion of a worksheet
-Select an area to print prior to actually printing
-To print a selection or range of a worksheet:
· Select the portion of the worksheet you want to print
· Click the Page Layout tab and then select the Page Setup dialog box launcher in the Page Setup group
· Click Print and then click Selection in the Print what section
· Verify the selection using Preview
-To set print areas:
· Press and hold the Ctrl key as you click and drag to select one or more areas in the worksheet
· Next, click Set Print Area in the Page Setup group on the Page Layout tab. This highlights the print area
· On executing the Print command, only the print area(s) are printed, with each print area appearing on a separate page
· Use Clear Print Area in the Page Setup group to clear print area
Excel Data Tables
Table: Is an area in the worksheet that contains rows and columns of similar or related information 
Table: Table tools Design Groups and Description 
Group
Properties: Properties of tables such as name and size. Resize table.
Tools:  Summarize with pivot table, remove duplicates, and convert table to a range
External Table Data: Export data, refresh table data when linked to external source 
Table style Options: Toggle headers, totals, first and last column, banded rows or columns on or off with check marks
Table styles: Select and apply styles from a gallery of options
Find and Replace
· Find and Replace allows global editing of data
· The field shown in column H is each player’s class
· Find and Replace is used to advance the class level at the end of each school year
-To use Find and Replace:
1. Select the field that is to be edited.
2. Select Replace from the Find & Select tab of the Editing group on the Home tab.
3. Enter the data to be changed in the Find What box.
4. Enter the data that will replace the changed data in the Replace with: box.
5. The user can change each occurrence individually or click Replace All to replace all occurrences at one time.
Table: Table Styles Options
Check box options
Header Row: Turn on or off the header or top row of a table
Total Row: Turns on or off the total or last row of a table 
 First Column: Shows special formatting for the first column of a table
Last column: Shows special formatting for the last column of a table
Banded Rows: Displays banded rows where even rows are differently formatted than odd rows
Banded Columns: Displays banded columns where even columns are differently formatted than odd columns
Sorting Data
Sorting: Arranges records in a table by the value in field(s) within a table
Sort command: Puts lists in ascending or descending order according to specified keys
Keys: Are the fields that records are sorted on
-To sort in ascending or descending order using one key cell:
1. Click in any cell in the column to be sorted.
2. Click either Sort A to Z or Sort Z to A in the Sort & Filter group on the Data tab
Data: Refer to facts about a specific record or sets of records
Information: Is data that have been arranged in some form and are viewed as useful
Use AutoFilters
· A quick way to display a subset of data from a table
· Filtered data displays only the records that meet the criteria you specify
· To apply a simple AutoFilter to a data table, click the arrow in the column header
14. Introduction to power point: presentations made easy
Parts of the PowerPoint Window
-On power point there is still the  Title bar, menu bar, scroll bar and document area 
-When you work with PowerPoint, remember that the digital presentation is a visual aid. The real star of the presentation should be the presenter.
PowerPoint Views
· Normal
· Slide sorter
· Notes page
· Slide show
-Four views are available in PowerPoint. Three of the views are used to prepare the presentation. The fourth is used to show the presentation to an audience.
Normal View: Is the Tri-pane default PowerPoint view
-Also provides access to the individual slides and speakers notes, each of which appears in its own pane
Notes page View:  Is used for entering and editing large amounts of text that the speaker can refer to when presenting 
In this view you see the slide at the top of the document window. As you type your notes, they will appear below the slide.
Slide Sorter view: Displays thumbnails of slides
-This view is helpful when you wish to reorder the slides in a presentation 
-Convenient way to delete one or more slide
Slide show view: Displays a full-screen view of a presentation 
-The slide show can be presented manually, where the speaker clicks the mouse to move from one slide to the next, or automatically, where each slide stays on the screen for a predetermined amount of time, after which the next slide appears.
Ribbon:  Is a command center that organizes commands into groups accessed from tabs
Tab: sits above the Ribbon and is used to organize or group like features for quick access 
Object: Is any type of information that can be inserted in a slide
Contextual Tab: is a specialty tab that appears only when certain types of objects are being edited
Gallery: displays a set of predefined options that can be clicked to apply to an object 
Table: Tab, Group, Description
Home: The core PowerPoint tab. Contains basic editing functions such as cut and paste, and finding and replacing text. Includes adding slides and changing slide layout. Formatting using font, paragraph, and drawing tools is available.
Clipboard, slides, font, paragraph, drawing, editing
Insert: Contains all insert functions in one area. Includes ability to create tables and illustrations. Hyperlinks, text boxes, headers and footers, WordArt, and media clips are inserted here.
Tables, illustration, links, text, media clip
Design: Contains all functions associated with slide design includ- ing themes and backgrounds. Change page setup and slide orientation here.
Page setup, themes, background
Animations: Controls all aspects of animation including transitions, advanced options, and customizing.
 Preview, animations, transition to this slide
Slideshow: Includes slide show setup, monitor set up, and timing. Options for starting the slide show available 
 Start slide show, set up, monitors
Review: Contains all reviewing tools in powerpoint, including such things as spelling and the use of comments 
 Proofing, comments, Protect 
View: Contains Presentation Views. Advanced view options include showing or hiding slides, zooming, and available color choices. Set window arrangement here. Enables macro creation.
 Presentation views, show/hide, Zoom, Colour/greyscale, window, macros
Add-Ins: Displays programs added to system that extend PowerPoint functionality. Does not display if supplemental programs are not installed.
 Custom toolbars
Screen tip: Is a small window that describes a command
Mini toolbar: Is a small, semitransparent toolbar that you can use to format text
Status Bar: Is a bar that contains the slide number, the design theme name, and view options
Thumbnail: Is a miniature of a slide that appears in the slides tab
Presenter view: Delivers a presentation on two monitors simultaneously
Metadata: Is data that describes other data
Document properties: Is the collection of metadata 

Storyboard: Is a visual plan that displays the content of each slide in the slideshow
- Give you the opportunity to brainstorm and get your initial ideas on paper.
-A storyboard helps you to organize your information. There are three sections used in a storyboard. The content section contains the information for each slide in the presentation.
Parts of a Presentation
· Introduction
· Body
· Conclusion
-The introduction of the presentation happens in the first few slides. 
It may be as simple as a title slide or more complex with a title which includes goals, objectives, or an agenda for the presentation. 
-The second part of the presentation is where you make your points or share your information. 
-The final part of the presentation is where you summarize your message.
 In this area, your slides will focus on your main points, your purpose, or what you want the audience to do. 
Power point tips
· Edit to short phrases
· Use bullet points
· Use active voice
· Be clear and concise
· Elements should support, not distract
· Be consistent
Slide layout: Determines the position of objects containing content on the slide
Placeholder: Is a container that holds content and is used in the layout to determine the position of objects on the slide
Theme: is a set of design elements that gives the slide show a unified, professional appearance
Custom Dictionary: is a supplemental dictionary Microsoft Office uses to store items such as proper names, acronyms, or specialized words
Table: is an illustration that places information in columns and rows
Four-headed move arrow
-Green circle
-Move and resize clip art
Transition: Is a movement special effect that takes place as one slide replaces another in Slide show view
Animation: Is movement applied to individual elements on a single slide
-Animation tabs
Animation Scheme: Is a built-in standard animation
Custom animation: is an animation where the user determines the animation settings
Annotation: Is a note that can be written or drawn on a slide for additional commentary or explanation 
Media Draws Audience Attention
·  Clip Art is usually line art. A vast amount of Clip Art is available via the Internet and Microsoft Office Online.
· Personal photographs or photographs from online sources can be used in presentations.
· A movie or short video that applies to your presentation can be used as a way for you to catch your breath during a presentation and make a point in a memorable way.
· Sounds can also add spice to the presentation. But just as your favorite recipe can have too much spice and end up tasting terrible, too much “sound spice” can distract your audience. You can record your own voice reading from a script, or use sounds from online sources. PowerPoint can play a wide variety of file format sounds from slide presentations.
· Animations can be applied to elements, thus causing them to appear on the screen in different ways. Repeated use of slow-moving animations can also bore your audience. Use them sparingly, especially with text elements.
Transitions allow your slides to move onto the stage in interesting ways. For instance, they can fade in, fly in, or checkerboard in. Consistency is the key with transitions. Otherwise your audience will begin to try to guess which method is coming with the next slide.


15. Presentation development: Planning and preparing a Presentation
Template: Is a file that incorporates a theme, a layout, and content that can be modified
 Business template 
-Available when you create a new presentation
Slide Layout: Controls the position of objects containing content on the slide
Place Holder: Is a container that holds content and is used in the layout to determine the position of objects on the slide
Sizing Handles: Are small circles or squares that appear at the corner and slides of a selected object  
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Outline: Is a method of organizing text in a hierarchy to depict relationships
Hierarchy: Denotes levels of importance in a structure
Outline view: Shows the presentation in an outline format with text levels
 Good to get a good overview of your presentation 
-An ideal way to create and edit presentations 
Editing the outline
· Cut
· Copy
· Paste
· Drag and drop
· Find and replace
· Apply formatting
-When working with an outline it is easy to see what information you have to work with and to move it from one part of the outline to another.
-The Copy, Cut and Paste commands work as they do in other Microsoft applications. 
A Collapsed outline: Displays the title of slides only in the outline view
Expanded outline: Displays the title and content of slides in the outline view
Data imports
Rich text format (.rtf):  Is a file type that retains structure and most text formatting when used to transfer documents between applications or platforms
Plain Text format (.txt): is a file type that retains only text when used to transfer documents between applications or platforms 
Colours gallery: Is a gallery with a set of colors for every available theme 
Font Gallery: contains font sets for title text and body text
Effects gallery: Includes a range of effects for shapes used in the presentation
-This aids the consistency of the look in your presentation 
-Effects in the gallery include a soft glow, soft edges to the shapes, shadows, or three-dimensional (3-D) look
Background Styles gallery: Provides both solid color and background styles for application to a theme
- The backgrounds fall into one of three areas: Subtle, moderate or intense. 
 Subtle backgrounds are a solid colour
 Intense are designed patterns such as checks, stripes or dots

Header: Is information that appears at the top of pages in a handout or notes page
Footer: Is information that appears at the bottom of slides in a presentation, or at the bottom of pages in a handout or notes page
-Insert tab
16. Presentation Design: Enhancing with Illustrations
Shapes: Is a geometric or nongeometric object, such as a rectangle or an arrow
-As a visual element in your presentation, to create an illustration, or ti highlight information
-Shapes command 
Callout: Is a shape that includes a line with a text box that you can use to add notes (speaking bubbles in comics) 
Adjustment handle: Is a control in the shape of a yellow diamond that allows you to modify a shape
-Lines as shapes are often used 
-To draw a line selects the line shape then dragging the mouse to create the line
-Double click to end the line 
A Connector: Is a line that is attached to and moves with shapes
-This is helpful for when shapes are rearranged, the connector line moves with it
-Three types of connectors are provided: Strait, elbow (to create angled lines), and curved
Flow chart: is an illustration showing the sequence of a project or plan 
-Connector lines join the shapes in the flow chart
Text box: is an object that enables you to place text anywhere on a slide
Freeform shape: Is a shape that combines both curved and straight lines to create a shape
-Drag to create lines and curves and double click to end the freeform shape
-To modify freeform shapes select the shape and then under Drawing Tools, click the Format tab
-Vertex: Is the point where a curve ends or the point where two line segments meet in a freeform shape
-Can be moved or deleted to redefine the objects shape
-THESE APPEAR AS BLACK DOTS (dots on shape you move to reform shape, usually appear at the corners) 
Quick style: Is a combination of formatting options available that can be applied to a shape or graphic (Kinda a gallery of what it could look like)
Selection Net: Selects all objects in an area defined by dragging the mouse 
-Used for selecting multiple objects on a slide
Fill: Refers to the inside of a shape
Gradient Fill: Is a blend of colours and shades
-To change shape fill go to the shape fill gallery
Transparency: Refers to how much you can see through a fill 
Opaque: refers a solid fill, one without transparency 
Picture fill: Inserts an image from a file into a shape
Texture Fill: Inserts a texture such as marble into a shape (such as canvas, denim, marble, and cork that can be used for the fill of the object)
Line weight: is the width or thickness of a line
Shape effects
-The ability to apply many stunning effects to shapes: present three-dimensional effects, shadow effects, reflections, glows, soft edge effects, bevels, and rotations
Smart Art: Is a diagram that presents information visually to effectively communicate a message
-This helps you to produce professional-looking slides that match the theme of your presentation. 
-Creating SmartArt is a little different than creating shapes. In SmartArt applications, you select text that has been typed on your slide and convert it to SmartArt. 
Table: Smart Art diagram
 Lists: Use to show non-sequential information. For example: A list of items to be checked on a roof each year
Process: Use to show steps in a process or a timeline. For example: The steps to take to wash car (arrows pointing and going into one another)
Cycle: Use to show a continual process. For example: The recurring business cycle (water cycle)
Hierarchy: Use to show a decision, tree, organization chart, or pedigree. For example: A pedigree chart showing the parents of an individual
Relationship: Use to illustrate connections for example: The connection between outdoor activities (circle graph kind of)
Matrix: use to show how parts relate to a whole. For example: Keirsey’s temperament theory involves for personalities (a bunch of squares)
Pyramid: Use to show proportional relationships with the largest component on the top or bottom. For example: an ecology chart 

Text pane:  Is a special pane that opens up for text entry when a SmartArt diagram is selected 
WordArt: Is text that has decorative effect applied
-In word art the special effect applied to the text itself, not a shape surrounding the text
Stacked: This term refers to the vertical alignment of text (text that starts from top and goes down)
Cropping: Reduce an images size by removing unwanted portions of an image
Aspect Ratio: Refers to the ratio of width to height
Grouping: Is combining two or more objects 
Ungrouping: Is breaking a combined object into individual objects

Selection Pane: Is a pane designed to help select objects
Stacking order: is the order of objects placed on top of each other 
-To change the order of a stack of shapes, select one of the shapes and then click Format under the Drawing Tools contextual tab
Grid: Is a set of intersecting lines used to align objects
Guide: Is a straight horizontal or vertical line used to align objects 
-You can place on a page to help line up objects 
Align: is to arrange in a line or so as to be parallel
Distribute: is to divide or evenly spread over a given area
17. PowerPoint Multimedia Tools: Enhancing with Multimedia
Multimedia: Is multiple forms of media used to entertain or inform a user or audience
 Clip art, diagrams and illustrations, pictures or photographs, scanned images, and other categories
Bitmap images: Are images created by Bits or pixels places on a grid that form a picture
-Each pixel in the image contains information about the colour to be displayed
-Bitmap image is like a real picture
-Pixels are best described as tiny dots of color placed in a grid.
Table: Types of graphic file formats supported by Power point 2007
Computer Graphics Metafile (.cgm)
-Older format originally used for clip art libraries. Often used for complex engineering drawings.
Enhanced Windows Metafile (.emf)
-Limited to 256 colors. Effective for scanned images such as illustrations rather than for color photographs. Good for line drawings and black and white images. Supports transparent backgrounds.
Joint Photographic Experts Group (.jpg .jpeg)
-Supports 16 million colors and is optimized for photographs and complex graphics. Format of choice for most photographs on the Web.
Macintosh (PICT)
-Holds both vector and bitmap images. PICT supports 8 colours; PICT2 supports 16 million colours
Microsoft Windows Metafile (.wmf)
-A windows 16-bit file format
Portable Network Graphics (.png)
-Supports 16 million colors. Approved as a standard by the World Wide Web Consortium (W3C). Intended to replace .gif format.
Tagged image file format (.tif, .tiff)
-Best file format for starting bitmapped images on personal computers. Can be any resolution. Lossless image storage creates large file sizes. Not widely supported by Web browsers
Vector Markup Language (.vml)
-An XML format for vector graphics that can be embedded in Web pages in place of bitmapped .gif and .jpeg images
Windows Bitmap (device Independent Bitmap) (bmp, .dib, .rle)
-A representation consisting of dots. The value of each dot is stored in one or more bits of data. Uncompressed and creates large file size.

Copyright:  is the legal protection afforded to a written or artistic work
Infringement of copyright: Occurs when a right of the copyright owner is violated 
Public domain: Is when the rights to a literary work or property are owned buy the public at large 

Photo album: Is a presentation containing multiple pictures organized into album pages
--The Photo Album option is available in the Insert tab, Illustrations group. The dialog box contains all of the settings you will need to create your Photo Album. 
 Movies: Are video files, or GIF files containing multiple images that stream to produce an animation 
Codec: (coder/decoder) is a digital video compression scheme used to compress a video and decompress for playback 
Table: Types of video formats supported by PowerPoint 2007
Movie file (.mpg or mpeg)
Moving Picture Experts Group Evolving set of standards for video and audio compression developed by the Moving Picture Expert Group. Designed specifically use with Video-CD and CD-I media
Windows Media File (.asf)
Advanced streaming Format stores synchronized multimedia data. Used to stream audio and video content, images and script commands over a network
Windows Media Video File (.wmv)
Windows media video Compresses audio and video by using windows media video compressed format. Requires a minimal amount of storage space on your computer’s hard drive
Windows Video file (.avi)
Audio Video Interleave stores sound and moving pictures in Microsoft Resource Interchange File Format (RIFF) format. Common format because audio or video content that is compressed can be stored in an .avi file

Embedded object: is an object from an external source stored within a presentation
-A movie link
Linked object: is an object stored outside the presentation in its own file

Table: Types of Audio File formats supported by PowerPoint 2007 
AIFF Audio File (.aiff)
-Audio Interchange File Format Waveform files stored in 8-bit monaural (mono or one channel) format. Not compressed. Can result in large files. Originally used on Apple and Silicon Graphics (SGI) computers.
AU Audio file (.au)
-UNIX Audio Typically used to create sound files for INIX computers or the Web
MIDI File (.mid or .midi)
Musical Instrument Digital Interface Standard format for interchange of musical information between musical instruments, synthesizers, and computers
MP3 Audio File (.mp3)
MPEG Audio Layer 3 Sound file that has been compressed by using the MPEG Audio Layer 3 codec (developed by the Fraunhofer institute)
Windows Audio File (.wav)
Wave Form Stores sounds as waveforms. Depending on various fac- tors, one minute of sound can occupy as little as 644 kilobytes or as much as 27 megabytes of storage.
Windows Media Audio File (.wma)
Windows Media Audio Sound format used to distribute recorded music, usually over the Internet. Compressed using the Microsoft Windows Media Audio codec (developed by Microsoft)

-Sounds are added using the Insert tab. 
-The Sound button brings up a dialog box that allows you to navigate to the sound file as you normally would for any file. 
Narration: Is spoken commentary that is added to a project
Before creating the narration, keep in mind the following: 
· Your computer will need a sound card, speakers, and a microphone. 
· Long narrations should be linked to the presentation rather than embedded. 
· Comments on selected slides maybe recorded rather than a narration of the entire presentation, which creates smaller file size. 
· Voice narration takes precedence over any other sounds during play back. 
· PowerPoint records the amount of time it takes you to narrate each slide, and if you save the slide timings, you can use them to create an automatic slide show. 
· When your record your presentation, you run through the presentation and record on each slide. You can pause and resume recording during the process. 
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